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CE Marking (Declaration of Conformity)

We declare under our sole responsibility that the copier and options to which this declaration relates is in conformity with the specifications below. This declaration 
is valid for the area of the European Union (EU) only.

This device must be used with shielded interface cables. The use of non-shielded cable is likely to result in interference with radio communications and is 
prohibited under EC Directives.

Software License Agreement

Before using the Software, please carefully read the following terms and conditions. BY USING THIS SOFTWARE, YOU SIGNIFY THAT YOU HAVE 
ACCEPTED THE TERMS OF THIS AGREEMENT.  If you cannot or do not accept these terms, you may return the entire package within ten (10) days to 
the Distributor or Dealer from which you obtained them for a full refund.

Electronics for Imaging, Inc. grants to you a non-exclusive, non-transferable license to use the software and accompanying documentation (“Software”) included 
with the Fiery X3e you have purchased, including without limitation the PostScript® software provided by Adobe Systems Incorporated.

Product Type Console Copier System

System Product 
Name

CF2001/1501 + Fiery X3e CF2001/1501, CF2001/1501 Options: AFR-16, FN-107, FN-108, JS-1002, AD-14, PF-117, PF-118, 
CT-2, M128-2, Counter, Copier Stand, I/F Kit J 

Compliance 
Report Number

EMC-2000-73, EMC-2000-74 

Standards Safety * 2 :  EN 60 950/1992 (A1, A2, A3, A4 & A11) 
(Safety of information technology equipment, including electrical business equipment) 
EN 60825-1 / 1994 with A11 (Copier only)
(Radiation safety of laser products, equipment classification, requirements, and user’s guide)

EMC *1 :   EN55 022 (Class B)/1998 (Limits and method for measurement of radio disturbance characteristics of information 
technology equipment (ITE))
EN61000-3-2/1995 (Electromagnetic compatibility (EMC)- Part 3: Limits, Section 2: Limits for harmonic current 
emissions (equipment input current ≤16A per phase))
EN61000-3-3/1995 (Electromagnetic compatibility (EMC)- Part 3: Limits, Section 2: Limitation of voltage fluctuations 
and flicker in low-voltage supply systems for equipment with rated current ≤16A
EN55024/1998 (Information technology equipment — immunity characteristics — Limits and methods of 
measurement
EN61000-4-2/1995 : Electrostatic discharge immunity test
EN61000-4-3/1995 : Radiated electromagnetic field immunity test
EN61000-4-4/1995 : Electrical fast transient/burst immunity test
EN61000-4-5/1995 : Surge immunity test
EN61000-4-6/1996 : Immunity to conducted disturbance, induced by radio-frequency field
EN61000-4-8/1993 : Power-frequency magnetic field immunity test
EN61000-4-11: Voltage dips, short interruptions and voltage variations immunity test

Notes: *1)  EMC performance: This product was designed for operation in a typical office environment.
*2) First year of labeling according to EC-directive 73/23/EEC and 93/68/EEC: 2000
3) This product was designed for operation in a typical office environment.

EC Directives Safety: 73/23/EEC and 93/68/EEC
EMC: 89/336/EEC and 93/68/EEC



         
You may:

a. use the Software solely for your own customary business purposes and solely with Fiery X3e;

b. use the digitally-encoded machine-readable outline and bitmap programs (“Font Programs”) provided with Fiery X3e in a special encrypted format (“Coded 
Font Programs”) to reproduce and display designs, styles, weights, and versions of letters, numerals, characters and symbols (“Typefaces”) solely for your own 
customary business purposes on the display window of the Fiery X3e or monitor used with Fiery X3e;

c. use the trademarks used by Electronics for Imaging to identify the Coded Font Programs and Typefaces reproduced therefrom (“Trademarks”); and

d. assign your rights under this Agreement to a transferee of all of your right, title and interest in and to Fiery X3e provided the transferee agrees to be bound by 
all of the terms and conditions of this Agreement.

You may not:

a. make use of the Software, directly or indirectly, to print bitmap images with print resolutions of 600 dots per inch or greater, or to generate fonts or typefaces 
for use other than with Fiery X3e;

b. make or have made, or permit to be made, any copies of the Software, Coded Font Programs, accompanying documentation or portions thereof, except as 
necessary for use with the Fiery X3e unit purchased by you; provided, however, that under no circumstances may you make or have made, or permit to be made, 
any copies of that certain portion of the Software which has been included on the Fiery X3e hard disk drive. You may not copy the documentation; 

c. attempt to alter, disassemble, decrypt or reverse engineer the Software, Coded Font Programs or accompanying documentation.

d. rent or lease the Software.

Proprietary Rights

You acknowledge that the Software, Coded Font Programs, Typefaces, Trademarks and accompanying documentation are proprietary to Electronics For Imaging 
and its suppliers and that title and other intellectual property rights therein remain with Electronics For Imaging and its suppliers. Except as stated above, this 
Agreement does not grant you any right to patents, copyrights, trade secrets, trademarks (whether registered or unregistered), or any other rights, franchises or 
licenses in respect of the Software, Coded Font Programs, Typefaces, Trademarks or accompanying documentation. You may not adapt or use any trademark or 
trade name which is likely to be similar to or confusing with that of Electronics For Imaging or any of its suppliers or take any other action which impairs or 
reduces the trademark rights of Electronics For Imaging or its suppliers. The trademarks may only be used to identify printed output produced by the Coded Font 
Programs. At the reasonable request of Electronics For Imaging, you must supply samples of any Typeface identified with a trademark.

Confidentiality

You agree to hold the Software and Coded Font Programs in confidence, disclosing the Software and Coded Font Programs only to authorized users having a need 
to use the Software and Coded Font Programs as permitted by this Agreement and to take all reasonable precautions to prevent disclosure to other parties.

Remedies

Unauthorized use, copying or disclosure of the Software, Coded Font Programs, Typefaces, Trademarks or accompanying documentation will result in automatic 
termination of this license and will make available to Electronics For Imaging other legal remedies.

Limited Warranty And Disclaimer

Electronics For Imaging warrants that, for a period of ninety (90) days from the date of delivery to you, the Software under normal use will perform without 
significant errors that make it unusable. Electronics For Imaging’s entire liability and your exclusive remedy under this warranty (which is subject to you returning 
Fiery X3e to Electronics For Imaging or an authorized dealer) will be, at Electronics For Imaging’s option, to use reasonable commercial efforts to attempt to 
correct or work around errors, to replace the Software with functionally equivalent software, or to refund the purchase price and terminate this Agreement. Some 
states do not allow limitations on duration of implied warranty, so the above limitation may not apply to you.

Except for the above express limited warranty, Electronics For Imaging makes and you receive no warranties or conditions on the Products, express, implied, or 
statutory, and Electronics For Imaging specifically disclaims any implied warranty or condition of merchantability or fitness for a particular purpose.

For warranty service, please contact your authorized service/support center.

EXCEPT FOR THE ABOVE EXPRESS LIMITED WARRANTY, ELECTRONICS FOR IMAGING MAKES AND YOU RECEIVE NO WARRANTIES 
OR CONDITIONS ON THE SOFTWARE OR CODED FONT PROGRAMS, EXPRESS, IMPLIED, STATUTORY, OR IN ANY OTHER PROVISION 
OF THIS AGREEMENT OR COMMUNICATION WITH YOU, AND ELECTRONICS FOR IMAGING SPECIFICALLY DISCLAIMS ANY IMPLIED 
WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Electronics For Imaging does not warrant that 
the operation of the software will be uninterrupted or error free or that the Software will meet your specific requirements.



          
Limitation Of Liability

IN NO EVENT WILL ELECTRONICS FOR IMAGING OR ITS SUPPLIERS BE LIABLE FOR ANY DAMAGES, INCLUDING LOSS OF DATA, LOST 
PROFITS, COST OF COVER OR OTHER SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES ARISING FROM THE USE OF 
THE SOFTWARE, CODED FONT PROGRAMS OR ACCOMPANYING DOCUMENTATION, HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY. THIS LIMITATION WILL APPLY EVEN IF ELECTRONICS FOR IMAGING OR ANY AUTHORIZED DEALER HAS BEEN ADVISED 
OF THE POSSIBILITY OF SUCH DAMAGE. YOU ACKNOWLEDGE THAT THE PRICE OF THE UNIT REFLECTS THIS ALLOCATION OF RISK. 
BECAUSE SOME STATES/JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR 
INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

Export Controls

You agree that you will not export or re-export the Software or Coded Font Programs in any form without the appropriate United States and foreign government 
licenses. Your failure to comply with this provision is a material breach of this Agreement.

Government Use

Use, duplication or disclosure of the Software by the United States Government is subject to restrictions as set forth in subdivision (c) (1) (ii) of the Rights in 
Technical Data and Computer Software clause at DFARS 252.227-7013 or in subparagraphs (c) (1) and (2) of the Commercial Computer Software—Restricted 
Right Clause at 48 CFR 52.227-19, as applicable.

Third Party Beneficiary

You are hereby notified that Adobe Systems Incorporated, a California corporation located at 345 Park Avenue, San Jose, CA  95110-2704 (“Adobe”) is a third-
party beneficiary to this Agreement to the extent that this Agreement contains provisions which relate to your use of the Fonts, the Coded Font Programs, the 
Typefaces and the Trademarks licensed hereby.  Such provisions are made expressly for the benefit of Adobe and are enforceable by Adobe in addition to Electronics 
For Imaging.

General

This Agreement will be governed by the laws of the State of California.

This Agreement is the entire agreement held between us and supersedes any other communications or advertising with respect to the Software, Coded Font 
Programs and accompanying documentation.

If any provision of this Agreement is held invalid, the remainder of this Agreement shall continue in full force and effect.

If you have any questions concerning this Agreement, please write to Electronics For Imaging, Inc., Attn: Licensing Dept. or see Electronics For Imaging’s web 
site at www.efi.com.

Electronics For Imaging, Inc.
303 Velocity Way
Foster City, CA 94404
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xiii About this manual

               
The Fiery X3e Color Server™ is a special-purpose controller board built into the 
copier. It enables you to use your copier as a high-speed networked color printer.

This manual is intended for Fiery X3e Color Server operators or administrators, or 
users with the necessary access privileges, who monitor and manage job flow and 
troubleshoot problems that may arise. It describes the functions and features of Fiery® 
utilities and Fiery WebTools™ for the purposes of print job management and color 
quality control.

If you have purchased the Command WorkStation™ option, the Fiery X3e Color 
Server includes Command WorkStation software, which enables an operator to 
manage all jobs sent to the Fiery X3e Color Server. Although it may not be the case at 
all sites, the documentation for this product assumes the presence of an operator who 
controls and manages jobs sent by users from remote workstations.

NOTE: The term “Fiery X3e” is used in this manual to refer to the copier in which the 
Fiery X3e Color Server is embedded.

About this manual
This manual is organized as follows:

• Chapter 1 describes the Fiery X3e Control Panel. It explains the various messages 
and icons that you might see and describes how to print system information pages. It 
also explains how to properly start up and shut down the Fiery X3e.

• Chapters 2 and 3 describe the Command WorkStation interface. The Command 
WorkStation application can be installed on networked Windows 95/98/Me/
NT 4.0 and 2000 computers, and used to view and manage virtually all aspects of 
Fiery X3e activity. In addition to providing a graphic display of the job flow, the 
Command WorkStation allows you to reprint or hold jobs, view and override print 
option settings, download files, manage printer fonts, preview print jobs, calibrate 
the Fiery X3e, and perform Setup (server configuration). The Command 
WorkStation also provides tools for archiving jobs and moving jobs between 
Fiery X3e color servers.

Preface
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• Chapter 4 introduces Fiery WebTools, explains how to access them, and directs you 
to sources of more information (in this manual or in other manuals in the 
documentation set).

• Chapter 5 describes Fiery WebSpooler and Fiery Spooler™, which can be used to 
view and manage Fiery X3e job activity. The interface and features of Fiery 
WebSpooler and Fiery Spooler have identical counterparts in the Command 
WorkStation; therefore, this chapter refers you to Chapters 2 and 3 for details about 
many Fiery WebSpooler and Fiery Spooler functions.

• Appendix A lists error messages that you might see on the Fiery X3e Control Panel, 
the Command WorkStation, Fiery WebSpooler, Fiery Spooler, or the copier, and 
contains some troubleshooting information.

Terminology
Specific terms are explained as they are introduced. However, the following general 
terms are used throughout:

• PostScript (PS)—A computer language designed as a page description language. The 
Fiery X3e uses this language for imaging the page and for communication with 
applications and with the print engine.

• Job—A file consisting of PostScript commands and comments that describe the 
graphics, sampled images, and text that should appear on each page of a document, 
and the printer options that should be used in printing, such as media or color 
rendering style.

• Spool—Write to a disk. Usually used here to refer to a PostScript print job being 
saved to the Fiery X3e hard disk in preparation for processing and printing.

• RIP—Acronym for raster image processing, which changes text and graphics 
commands into descriptions of each mark on a page. In common use as a noun, a 
“raster image processor” (RIP) is the computer processor that performs this function.

• Print—The process of rendering, or imaging, a page or a job on a printer.

These concepts can explain how the Fiery X3e Color Server and the copier work 
together as a powerful printing system. The Fiery X3e PostScript RIP changes text and 
graphics commands in PostScript into color specifications for each dot of toner 
deposited on a page by the copier.
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About the documentation
This manual is part of the set of Fiery X3e documentation, which includes the 
following manuals for users and system administrators:

• The Configuration Guide explains basic configuration and administration of the 
Fiery X3e for the supported platforms and network environments. It also includes 
guidelines for setting up UNIX, Windows NT 4.0, and Novell NetWare servers to 
provide PostScript printing services to clients.

• Getting Started describes how to install software to enable users to print to the 
Fiery X3e. Specifically, it describes installation of PostScript printer drivers, printer 
description files, and other user software provided on the User Software CD and Job 
Management Tools CD. It also explains how to connect each user to the network.

• The Printing Guide describes the printing features of the Fiery X3e for users who 
send jobs via remote workstations on the network or via a direct parallel port 
connection.

• The Color Guide provides an introduction to the basics of color theory and printing 
to a Fiery X3e Color Server. It also includes practical color printing tips and 
application notes that explain how to print to the Fiery X3e from popular Windows 
and Mac OS applications.

• The Job Management Guide explains the functions of the Fiery X3e client utilities, 
including the Command WorkStation, and how they can be used to manage jobs 
and maintain color quality. This book is intended for an operator or administrator, 
or a user with the necessary access privileges, who needs to monitor and manage job 
flow, perform color calibration, and troubleshoot problems that may arise.

• Release Notes provide last-minute product information and workarounds for some of 
the problems you may encounter.
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Fiery X3e job environments
The Fiery X3e supports several levels of control of printing, job management, and 
setup, and offers you the flexibility to choose the configuration that corresponds to the 
requirements of your site. Your situation may correspond to one of the descriptions 
outlined below, or you may prefer an intermediate level of control.

At one extreme, an administrator or operator in a high-volume printing environment 
controls the entire job flow and all printing. Print jobs arriving from remote users are 
spooled to the server disk and stored until the operator decides it is time to print them. 
Additional functions (calibration, job overrides, prioritizing, font management) are 
reserved for the administrator or operator.

At the other extreme, anyone on the local network can control all printing and server 
functions; operator intervention is not necessary. Users can print from their 
workstations to any of the published print connections. Anyone can use the Command 
WorkStation, or Fiery WebSpooler, or Fiery Spooler to control any print job.

The spectrum of control that an administrator can implement is described in the 
Configuration Guide.

Permissions
Support for these job environments is achieved by a combination of Fiery X3e Setup 
options. By default, anyone can access Setup, but the administrator can limit access to 
Setup by specifying an Administrator password for the Fiery X3e (see the Configuration 
Guide).

Also by default, anyone can log in to the Command WorkStation, Fiery WebSpooler, 
or Fiery Spooler and control job flow, but an administrator can restrict access to these 
functions by specifying an Operator password.
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The three security levels from greatest to least control are:

• Administrator—confers control of Setup and is the highest level of control. The 
person who has access to Setup can control the printing and job management 
environment by enabling print connections and setting passwords. The 
Administrator can also manage the fonts on the server, clear the server disk when 
necessary, and set a common web link for all users who log in to the Fiery X3e using 
their web browser. 

• Operator—includes control of print jobs that arrive at the server and the ability to 
perform calibration and reboot the server.

• Guest—allows users to view the status of active jobs and the list of stored jobs. They 
cannot make changes to jobs or change their printing instructions. A password is not 
needed to log in as Guest and view jobs from the Command WorkStation, or Fiery 
WebSpooler, or Fiery Spooler windows.

This manual describes the features of the Fiery client utilities, including the Command 
WorkStation, and all operator privileges, whether those privileges are available to 
everyone or are exclusive to only certain people. It also includes descriptions of 
administrator functions and provides references to other manuals for more 
information.
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1-1 Using the Control Panel

     
You can use the Control Panel on the copier to access all basic functions of the 
Fiery X3e, access special features, view status and information about jobs printed to the 
Fiery X3e, view copier error messages, print system pages, run diagnostics, and 
configure Fiery X3e Setup options. For information about Setup options and how to 
use them, see the Configuration Guide.

Using the Control Panel 

The parts of the Control Panel that control functionality of the Fiery X3e are:

Menu button Enters the Functions menus. From a Setup menu 
option, returns to the previous Setup menu. 

Activity light Off—Off when the Fiery X3e is off or starting up.
Solid red—Solid red for more than 30 seconds may 
indicate a communication error between the Fiery 
X3e and the copier.
Blinking red—Flashes red when there is an error that 
prevents printing.
Solid green—Solid green indicates normal state.
Blinking green—Flashes green when the Fiery X3e is 
RIPping or printing a job, or communicating with a 
remote computer (for example, through Fiery 
Spooler). 

Chapter 1:
Operating the 
Fiery X3e

Ready light

Menu button

Set button

Up, down, left, and right buttons

Cancel button

Display window
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1-2 Operating the Fiery X3e

            
Control Panel Display status messages
When the Fiery X3e has control of the Control Panel, the LCD provides information 
about the current status of the Fiery X3e.

Control Panel Display status messages are:

Navigation buttons Up arrow—In Setup menus, advances from one 
menu to the next. When entering numbers or text, 
increments to the previous number or character. 

Down arrow—In Setup menus, advances from one 
menu to the previous. When entering numbers or 
text, decrements to the next number or character. 

Right arrow—Advances the cursor to the text-entry 
position to the right.

Left arrow—When entering numbers or text, 
backspaces and deletes.

Set button Activates the currently selected option and, if 
applicable, proceeds to the next menu.

Cancel button In Setup menus, exits menus entirely, returning to 
Info. While printing, Cancel stops printing or 
processing the current job. 

Loading system Appears during startup. 

Info
<Server Name>

Appears when the Fiery X3e is idle.

Info
Idle

Appears when the Fiery X3e is idle and the Down arrow is 
pressed once.

Info
#MB       #v

Appears when the Fiery X3e is idle and the Down arrow is 
pressed twice. #MB indicates the amount of free space on 
the Fiery X3e hard disk; #v indicates the version of system 
software currently running on the Fiery X3e.

<Server Name>
Processing

Appears when the Fiery X3e is processing a job. The activity 
light flashes green.
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1-3 Using the Control Panel

         
The Control Panel screen displays basic information about the Fiery X3e. When the 
Fiery X3e is neither processing nor printing a job, the LCD appears as shown below.

NOTE: If the Fiery X3e is idle for more than the default time of two minutes, control of 
the Control Panel returns to the copier. Press the Menu button to return control to the 
Fiery X3e. 

<Job Name>
Busy      #K

Appears when the Fiery X3e is processing a job. The #K 
value increases to indicate the amount of the job that has 
been processed. The activity light flashes green.

Sending
<Job Name>

Appears when a special page from the 
Functions>Print Pages menu is printing. Job Name 
indicates the type of page. The activity light flashes green. 

<Server Name>
Printing

Appears when the Fiery X3e is printing a job. The activity 
light flashes green.

<User Name>
Copies: #C/#T

Appears when the Fiery X3e is printing a job. #C indicates 
the copy currently printing; #T indicates the total number 
of copies in the job. The activity light flashes green.

Canceling
Print job

Appears when the Cancel button has been pressed and the 
currently printing or processing job is being canceled.

Disconnecting
20C-M

Appears when Suspend Print has been selected from the 
Functions menu. 

Connecting
20C-M

Appears when Resume Print has been selected from the 
Functions menu.

Calibration Appears when calibrating the Fiery X3e. For more 
information, see the Color Guide. If an Administrator 
password has been set, you must enter it to access the 
Calibration menus.
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Press the Functions key to display the Functions menu. The following options are 
available:

Print Pages Select to print system pages from the Fiery X3e. You can 
print the following pages from the submenu that appears:

Test Page—Enables you to confirm that the Fiery X3e is 
properly connected to the copier. The Test Page provides 
sample images and color samples. The following 
information is also listed: Server name, Printer model, color 
settings, calibration information, and date and time 
printed.

Configuration—Gives the current Fiery X3e and device 
configuration. This page lists general information about the 
hardware and software configuration of the Fiery X3e, the 
current options for all Setup settings, information about the 
current calibration, and if applicable, the Ethernet addresses 
of the Fiery X3e.

Job Log—A list of the last 55 print jobs. For information on 
the fields in the Job Log and on printing it in other forms, 
see “Job Log window” on page 2-26.

Control Panel Map—The Control Panel Map provides an 
overview of the menus you can access from the Control 
Panel Display. For information about using these menus to 
set up the Fiery X3e, see the Configuration Guide.

Color Charts—Prints samples of the RGB, CMY, and 
PANTONE colors available from the Fiery X3e. 

Font List—A list of all PostScript fonts resident on the 
Fiery X3e hard disk.
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Rebooting, shutting down, and restarting the Fiery X3e
Generally, you can leave the Fiery X3e and the copier running all the time. This section 
describes how to reboot, shut down, and restart when necessary.

Rebooting the Fiery X3e
When you reboot the Fiery X3e, fonts that have been downloaded to the hard disk 
drive are not deleted. Print jobs in the Hold queue, the Printed queue, and jobs that 
have been processed but not printed are not deleted; they will be available for printing 
when you restart the Fiery X3e.

Suspend Printing Temporarily interrupts communication between the 
Fiery X3e and the copier. Select Suspend Printing if you 
want to pause the currently printing Fiery X3e job in order 
to use the copier to make copies.

After selecting Suspend Printing, jobs continue to process 
on the Fiery X3e. When copying is completed, select 
Resume Printing to continue printing the interrupted 
Fiery X3e job.

Resume Printing Re-establishes communication between the Fiery X3e and 
the copier.

Shut Down Accesses the Shut Down menus.

Clear Server Clears all jobs in all Fiery X3e queues as well as all jobs 
archived on the Fiery X3e hard disk, the index of archived 
jobs, and the Job Log.

Run Setup Accesses Setup menus.

Run Diagnostics Enables authorized service/support technicians to run 
diagnostic tests on the Fiery X3e and the copier.

Calibration Accesses the Calibration menus. Requires a password, if one 
has been set.
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To reboot the Fiery X3e, when the Control Panel reads Idle, press the Menu button to 
access the Functions menu. Use the Down arrow button to scroll to Shut Down. Press 
the Set button. Use the Down arrow button to scroll to Reboot System. Press the Set 
button. For information on accessing the Setup menus, see the Configuration Guide.

Shutting down the Fiery X3e
You may need to shut down the Fiery X3e for service. When you do so, fonts that have 
been downloaded to the hard disk drive are not deleted. Print jobs in the Hold queue, 
the Printed queue, and jobs that have been processed but not printed are not deleted; 
they will be available for printing when you restart the Fiery X3e.

To shut down the Fiery X3e, when the Control Panel reads Idle, Press the Menu 
button to access the Functions menu. Use the Down arrow to scroll to Shut Down. 
Press the Set button. Use the Down arrow to scroll to Shut Down System. Press the Set 
button. When you see the message “It is now safe to power off the system”, turn off the 
copier using the main power switch.

NOTE: After turning the copier off, wait at least three seconds before turning it back on.

Main power switch:
Press up to power on

Press down to power off
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Restarting the Fiery X3e
To restart the Fiery X3e, move the main power switch on the copier to the On 
position. Wait approximately three seconds, and press the Menu button on the 
Control Panel to access the Functions menu. Use the Down arrow to scroll to Shut 
Down. Press the Set button. Use the Down arrow to scroll to Reboot Server. Press the 
Set button.

If an error occurs during startup, the activity light flashes red. Check the Control Panel 
display for details of the error.
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This chapter introduces you to the graphical user interface of the Command 
WorkStation. Select a user level and log in to the Fiery X3e. Once you have logged in, 
you can tour the Command WorkStation windows. Your exploration will be more 
complete if you have some jobs in the Spool area (jobs printed to the Hold queue) and 
have the ability to send more jobs from a nearby computer.

Chapter 3 builds on the information in this chapter and describes job monitoring and 
control in more depth. 

About the Command WorkStation
The Command WorkStation provides a window on Fiery X3e and copier functions, 
and an interface from which you can control those functions. The Command 
WorkStation application can be installed on a Windows 95/98, Windows NT 4.0, or 
Windows 2000 computer with a TCP/IP or IPX network connection to the Fiery X3e.

By default, no passwords are set on the Fiery X3e—in this default state, anyone can 
perform Setup and use all Command WorkStation functions. Until an Administrator 
password is defined in Fiery X3e Setup, you can log in to the Command WorkStation 
as an Administrator without entering a password, and you are given full privileges 
which include:

• A view of current printing jobs and jobs stored on the Fiery X3e

• Control of printing jobs

• Ability to perform calibration

• Access to Setup, management of resident fonts, clearing of the Fiery X3e disk and 
the Job Log

After the Administrator has performed Setup and specified passwords, Command 
WorkStation user options depend on your login level. If you log in to the Command 
WorkStation as Guest, you have the first option only. If you log in as Operator, you 
have the two options. If you log in as Administrator, you have all four options. For 
information about Setup and specifying passwords, see the Configuration Guide.

Chapter 2:
Introduction to 
the Command 
WorkStation
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After you connect to the Fiery X3e and log in, your first view of the Command 
WorkStation is the Queues window (as indicated by the tab at the bottom) which is 
divided into three regions by Spool, RIP, and Print status bars. The Queues window is 
surrounded by a frame that includes slider buttons and menus.

Once the Fiery X3e receives print jobs, the Queues window becomes a dynamic 
display, filled with the names of jobs and their characteristics. Status bars animate in 
real time as new jobs are processed and printed, and jobs move to different display 
areas. An operator, who has complete job control, sets the process in motion for each 
job.

The Spool, RIP, and Print areas of the Queues window represent the stages of printing 
a job. Jobs come in at the top level (Spool) and drop down to the Print level, unless 
they are held along the way.

• Spooled jobs—Jobs listed below the Spool status bar area are PostScript files stored 
on the Fiery X3e disk. These jobs were sent to either the Print queue (white printer 
icons) or the Hold queue (yellow icons). 

• RIPped jobs—Jobs listed below the RIP status bar are ready to print. They have 
already been rasterized (RIPped, or processed for printing) and are waiting, in order, 
for access to the printer. Rasterized jobs can also be held; held jobs are displayed on a 
yellow background.

• Printed jobs—Jobs listed below the Print status bar have already been printed. 
Printed jobs can be stored on the Fiery X3e disk. The number of jobs that can be 
stored (from 1 to 99) is defined in Setup.

You can interact with jobs in the window by selecting them and choosing from Job 
menu commands or right-mouse menu commands, or by double-clicking them. 
(However, if passwords have been set and you log in as Guest, you can only view jobs; 
you cannot change or route them.) This chapter and the next explain the Command 
WorkStation interface in detail.
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Starting up and logging in
To start up the Command WorkStation application, click the Windows Start button 
and choose Command WorkStation from the Programs menu; or, if you have created a 
shortcut to the Command WorkStation application, double-click the Command 
WorkStation icon.

Connecting to the Fiery X3e
If the Command WorkStation was previously connected to the Fiery X3e, you are 
prompted to choose it from a list of servers.

NOTE: If the Command WorkStation has never been connected to the Fiery X3e, you 
are prompted to configure an entry for it. Click OK and see Getting Started for 
instructions on how to configure a new connection.

With the Fiery X3e device name (20C-M) selected, click OK. If the device name is not 
displayed, click the plus sign (+) to expand the Fiery X3e entry.

The Command WorkStation connects to the Fiery X3e and you are prompted to 
choose a login level and enter a password to log in (see below). If you have any 
difficulties connecting to the Fiery X3e, see Appendix A for error messages and 
troubleshooting information.
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Logging in
When the Command WorkStation has connected to the Fiery X3e, the log in/out 
slider appears, prompting you to select a login level and enter a password. Before you 
log in, the Administrator key is in the vertical position, and the Operator, 
Administrator, and Guest keys are in the flat (horizontal) position. When you click 
your login level, the corresponding key turns to the vertical position.

For Administrator or Operator access to the Fiery X3e, click the corresponding key, 
enter the password, and click Log in or press Enter. For Guest access only, click the 
Guest key and then click Log in. No password is required for Guest access.

If you change your mind about logging in, or do not have the password you need, click 
Cancel.

When you have entered the appropriate password and logged in, the log in/out slider 
retracts and the full Command WorkStation display appears. The color of the key in 
the lock indicates your login level. If the Fiery X3e is handling a large number of jobs, 
it may take a few moments to display the entire job list.

When you reopen the slider after you have logged in, the Log in button will have 
changed to the Log out button.

Access levels

The three possible levels of access to Command WorkStation functions are 
Administrator, Operator, and Guest. To enable maximum password protection, 
Administrator and Operator passwords must be specified in Setup (see the 
Configuration Guide).

Log in/out slider



22-5 The Command WorkStation interface
When both Administrator and Operator passwords have been specified, the access 
levels are as follows:

NOTE: Access privileges alone do not confer control of print jobs. If the operator is 
going to manage all print jobs, the Administrator must route all user jobs to the Hold 
queue (that is, all jobs are spooled and held on the Fiery X3e). To accomplish this, only 
the Hold queue, and not the Direct connection or the Print queue, should be enabled 
in Setup. See the Configuration Guide for more information.

Logging out
There are two ways to log out from the Fiery X3e:

• From the Server menu, choose Log out

• Open the log in/out slider (click the key icon just below the Fiery logo) and click 
Log out

The Command WorkStation interface
The display illustrated below is the default Command WorkStation display in the 
middle of job processing. It shows the elements common to all Command 
WorkStation displays (1 through 4) and the Queues window elements (5 through 8). 
There is another window, Job Log, which you access with a tab at the bottom of the 
display (3). However, the Queues window is the one from which most Command 
WorkStation operations are performed. There are two other windows, Archive and 
Job Log, which you access via tabs at the bottom of the display (3).

Access level: Privileges and password requirements:

Administrator Has full access to all Command WorkStation and Control Panel 
functions; Administrator password required

Operator Has access to all Command WorkStation functions except Setup, 
calibration, clearing the Fiery X3e disk, clearing the Job Log, and font 
management; Operator password required 

Guest Can view job status, but cannot make changes to jobs or Setup, and can 
view the Queues window only; no password required
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The elements numbered 1 through 4 are common to all Command WorkStation 
displays, those numbered 5 through 7 appear only in the Queues window, and element 
number 8 is common to the Queues and Archive windows. 

The Command WorkStation provides access to a great deal of information and many 
features that are accessed in various ways—buttons, menus, double-clicking, and 
right-mouse commands. It is a powerful interface that allows for a great deal of 
interaction and flexibility in the production process. This section describes each of the 
elements that compose the Command WorkStation display.

1 Server selection tabs

2 Sliders and system information

3 Window selection tabs

4 Job ticket information

5–8 Queues window display

1

2

3

4
5

6

7

8
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Window area (Queues, Archive, Job Log)
This area can display one of three windows: the Queues window (shown below), the 
Archive window, or the Job Log window (only the Queues window is available if you 
logged in as Guest). The Queues window is the default window; it shows spooled, 
processing, and printing jobs in a display that changes dynamically.

For information on: See:

Queues area “Queues window” on page 2-14

Archive area “Archive window” on page 2-24

Job Log area “Job Log window” on page 2-26



22-8 Introduction to the Command WorkStation
Menu bar
The menu bar has six menus. When an action is not available in the current context, 
the command is dimmed.

Menu: Choose this: To do this:

File Preferences Set Command WorkStation preferences; see page 3-4.

Print Pages Print any or all of the following pages to the Fiery X3e: 
Configuration page, PS Test Page, Control Panel Map, PS Font 
List, Color Charts, Job Log. You can also print the Configuration 
page to any printer you specify; see page 3-6.
Print any or all of the following pages to a local printer: 
Configuration, Archive Log, Queues.

Exit Log out from the Fiery X3e, exit the Command WorkStation 
application, and return to the Windows desktop.

Job 
(For more 
information 
on these 
commands, 
see page 2-21)

Delete Delete one or more selected jobs.

Duplicate Duplicate one or more selected PostScript data jobs in the Spool or 
Print areas; see page 2-18, page 2-20, and page 2-21.

Rename Rename a selected job.

Hold Hold the selected job(s); see page 2-16.

RIP and Hold RIP and then hold the selected job(s); see page 2-16.

Print Print the selected job(s); see page 2-20.

Print and Hold Print the selected job(s) and then hold it in the RIP area; see 
page 2-16.

Process Next Give top priority to this job (Spool area only).

Remove Raster Remove the raster information from the selected job(s); see 
page 2-22.

Properties View and edit print settings for the selected job(s) and print job(s) 
with new settings; see page 2-32.



22-9 The Command WorkStation interface
Job 
cont.
(For more 
information 
on these 
commands, 
see page 2-21)

Thumbnail A This option is not available.

Thumbnail B This option is not available.

Download Download files and fonts to the Fiery X3e; see page 3-14. You can 
also choose this command by right-clicking on the Spool status bar.

Archive Archive one or more selected jobs; see page 2-24 and page 3-20.

Import Retrieve one or more archived jobs from an external device; see 
page 3-22. You can also choose this command by right-clicking on 
the Spool status bar.

Send to<Nickname_Devicename> Send the selected held job(s) to another connected Fiery X3e; see 
page 3-19.

Page Delete This option is not available. 

Duplicate This option is not available. 

Preview This option is not available. 

Undo This option is not available. 

Server Cancel RIPping Stop RIPping the current job. You can also choose this command 
by right-clicking on the RIP status bar.

Cancel Printing Stop printing the current job. You can also choose this command by 
right-clicking on the Print status bar.

Suspend Printing Temporarily halt printing. You can also choose this command by 
right-clicking on the Print status bar.

Resume Printing Restart printing (after a Suspend Printing command). You can also 
choose this command by right-clicking on the Print status bar.

Manage Fonts View the fonts currently installed on the Fiery X3e disk, download 
additional fonts, or delete fonts (requires Administrator privileges); 
see “Managing server fonts” on page 3-17.

Manage Color Start ColorWise Pro Tools; see the Color Guide.

Clear Job Log Clear all jobs from the Job Log (requires Administrator privileges); 
see “Other server management commands” on page 3-25.

Menu: Choose this: To do this:
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Server selection tabs

The Server selection tabs, just below the menu bar at the top of the display, can be used 
to log in to additional Fiery X3e servers and to switch between Fiery X3e servers 
currently connected to the Command WorkStation.

Server
cont.

Reboot Perform a soft reboot of the Fiery X3e (requires Operator or 
Administrator privileges); see “Other server management 
commands” on page 3-25.

Clear Clear all jobs in all queues as well as all jobs archived on the 
Fiery X3e hard disk, the index of archived jobs, and the Job Log 
(requires Administrator privileges); see “Other server management 
commands” on page 3-25.

Setup Start the Fiery Setup program (requires Administrator privileges); 
see “Other server management commands” on page 3-25 and the 
Configuration Guide.

Log out Log out of the Fiery X3e.

Window Filter Open the Filter dialog box for the active window; see page 2-28.

Export Save the information in the active window as a tab-delimited text 
file; see page 2-26, and page 2-27.

Print Print the active window.

View in Helper App Open the active window in a particular application you specify; see 
page 3-5.

Refresh Update the Job Log window with the latest information.

Revert to Default Settings Restore default settings for the status areas, the column headings, 
and the column widths.

Help About View the Command WorkStation information screen.

Menu: Choose this: To do this:
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If you click a blank tab, you are prompted to connect to one of the Fiery X3e servers in 
the list or configure a new Fiery X3e entry (see “Connecting to the Fiery X3e” on 
page 2-3). A limit of five Fiery X3e servers can be connected to a single Command 
WorkStation.

You can access the Server selection tabs from all Command WorkStation windows 
(Queues, Archive, and Job Log).

Sliders
Along the left side of the display are buttons you click to activate function sliders.

To retract any slider, click the icon at the far right of the slider.

Click to view Fiery X3e 
information

Click to open the log in/out slider

Click to start a Fiery utility

Click to view disk space and 
RAM availability
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Server information slider

The Server information slider displays name and version information about the 
currently connected Fiery X3e and the Command WorkStation. To retract the slider, 
click the Fiery logo at the far right of the bar.

Log in/out slider

This slider is described in “Logging in” on page 2-4 and “Logging out” on page 2-5. To 
retract the slider, click the lock icon at the far right of the bar.

Utilities shortcut slider

This slider can be used to access the Fiery Downloader and ColorWise Pro Tools 
utilities. These utilities can also be accessed from the Job menu and Server menu, 
respectively. To retract the slider, click the icon at the far right of the bar.

Disk space and RAM slider

The System information indicators show the current availability of hard disk space and 
RAM on the currently selected Fiery X3e. To retract the slider, click the icon at the far 
right of the bar.

Total RAM Total hard disk capacity

RAM currently in use

Disk space used
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Job ticket information

All the jobs listed by name in the Queues and Archive windows can display the job 
ticket information specified by the person who originated the print job. The 
Command WorkStation can display this information because it parses the PostScript 
file before it is RIPped. 

You have considerable flexibility in arranging this information in the display. For 
example, you can add Media Type to the display if you want to see which jobs call for 
special paper or other media. 

You can choose not to display headers for options that are not used at your site, or you 
can display all possible options and scroll to see the ones that are less important to you. 
If you just want to experiment, when you are finished you can choose Default Settings 
from the Window menu.

For instructions on customizing the display in the Queues and Archive windows, see 
page 3-4.

Window selection tabs

The Command WorkStation always starts out by displaying the Queues window, from 
which you view current job processes and control job flow and file storage. To go to 
another window, click the corresponding tab at the bottom of the Command 
WorkStation display.
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Queues window
The Queues window is a dynamic display of the job staging area: jobs are lined up for 
processing and printing, some of them are being held waiting for directions, some are 
moving from one stage or queue to another and are finally dropped from the list, some 
are held for processing by the operator, and some are held in a different queue in case 
you need to reprint them.

One approach to understanding the dynamic display is to imagine the three parts of 
the Queues window corresponding to the three stages of printing, illustrated as a 
downhill flow.

Spooling—a PostScript file is saved on the Fiery X3e hard disk. The file can come in 
packets from the network, or from another place on the Fiery X3e hard disk. Jobs are 
added to a queue in the order in which they arrive, and they generally move to another 
queue in the same order unless an operator has intervened to change the order. 

Rasterizing (RIPping)—PostScript commands are interpreted in the Fiery X3e to allow 
the copier to print the file the way its originator intended. The result of this 
interpretation is a raster file associated with the original PostScript file. In this raster file 
(raster image), color data is associated with each dot that can be rendered by the print 
engine. The color data tells the print engine whether or not to apply cyan, magenta, 
yellow, or black toner to each position on the page.

Printing—The raster image is transferred from the Fiery X3e to the print the print 
engine at high speed, freeing up RAM for the next job. While the PostScript file is 
usually saved to disk, raster images are held in RAM during and after each print job. 
However, both users and operators can request that the Fiery X3e save the raster image 
to disk along with the PostScript file.

Saving the raster image to disk offers some advantages—raster files are already 
processed so they print quickly, and each part of the raster file is still identified with a 
page in the original document, which means that individual pages of a saved raster file 
can be accessed.

Spooling

RIPping

Printing
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Status bars
Jobs actively involved in the three processes (spooling, rasterizing, and printing) are 
listed in the status bars that span the Queues window.

Status bars show the filename, and user name for the active process, and an indication 
of its progress. Each status bar heads the list of jobs that have completed the process. 
Thus, beneath the Spool status bar, you see a list of spooled files; beneath the RIP 
status bar, you see a list of rasterized (RIPped) files; beneath the Print status bar, you 
see a list of jobs that have already been printed.

NOTE: In the Spool status bar, the filename and user information always appear as 
“Unknown” (as shown below). This information is not available until the job has 
finished spooling to the Fiery X3e disk.

When a job is being processed, provided animation is enabled (see page 3-5), the 
corresponding status bar is animated, indicating that the process is active. Each status 
bar lists the filename of the active job, the user name, and an indication of its size or 
progress.

If an error occurs, the Print status bar alerts you by displaying a message on a red 
background instead of the normal blue background. 

Spooled jobs on Hold (yellow)
Active spooled jobs (white)

RIPped jobs on Hold (yellow)
Active RIPped jobs (white)

Printed jobs (white); some include 
raster files in RAM
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Enlarging the status bars  Click the small arrows at the left of the status bar to 
expand the status bar display. Click the arrows again to collapse the status bar to its 
original size. To expand all the status bars at the same time, press Ctrl-E. To collapse 
them to their original size, click the arrows or press Ctrl-E again.

Changing proportions  By default, the status bars divide the window area into three 
equal parts. You can drag the RIP and Print status bars up or down to change the 
proportion of the window devoted to each job area. For example, drag the RIP status 
bar down if you have a long list of spooled jobs that you want to see without scrolling.

Making space  If your workflow includes holding many jobs, and you don’t want to 
view the held jobs all the time, consider moving some of them to the Archive window. 
You can move jobs back and forth between the Queues window and the Archive 
window with a single right-mouse command (see page 2-21).

Active jobs and held jobs

In the description that follows, assume that the operator has full control of jobs; that is, 
the administrator has disabled the Direct connection and the Print queue, and all user 
jobs come to the Hold queue. For more information about queues, see the 
Configuration Guide.
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The operator’s job management functions permit holding a job at any stage of the 
process we have described, as illustrated below. In the figure, boxes indicate types of job 
icons you would see in the Queues window. 

Spooled and held

RIPped and held

Print and hold

RIP

Print

Printed

PostScript and 
raster data

Deleted

Spool

Spooled for printing

RIPped for printing

Print*

*A copy of the held job is printed; the held job remains in the RIP area.

PostScript data
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Jobs that are held are shown with a yellow icon in a yellow row, just beneath the Spool 
or RIP status bar. Jobs that are held must be activated with a command in order to 
print.

Active jobs are shown in white with white icons; new jobs are added above older jobs.

Job icons
There are three types of icons that are used for both active jobs and jobs on hold.

Spool area
The job icons in the Spool area are described below: 

Icon: Active jobs:
(white icons and rows)

Jobs on Hold:
(yellow icons and rows)

Printer icons

PostScript or raster data 
headed for printing (top) or 
after printing (bottom)

PostScript data headed for Print 
and Hold or job on Hold after 
printing (Hold)

Spool area icon: What it indicates: How long you see the job:

1

Yellow printer icon 
Yellow job row

PostScript data from a user on 
the network; no destination is 
defined

Until a destination is chosen

2

White printer icon 
White job row 

PostScript data headed for 
Print

Until the RIP is free

3

Yellow raster icon 
White job row 

PostScript data headed for 
RIP and Hold
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The Spool area is both the receiving area for jobs from users on the network (Hold 
queue) and the waiting area for jobs that will be RIPped (jobs in the Spool queue).

Hold queue jobs  When printing requires an operator (because the Print queue and 
Direct connection are disabled), the operator must assign a destination to all jobs 
received from users on the network (icon 1 in the table above). Once assigned, jobs 
(icons 2 and 3) move down the Spool queue for processing. All jobs printed to the 
Hold queue require routing by an operator.

Print queue jobs  When printing does not require an operator, network jobs sent to 
the Print queue appear in the Spool area where they are shown with a white printer 
icon (icon 2). When they reach the head of the queue, they are RIPped and printed 
without operator intervention.

Direct connection jobs  Jobs printed to the Direct connection are not displayed in the 
Command WorkStation job lists. They are displayed briefly in the status bars (where 
they cannot be selected) and are included in the Job Log.

RIP area
The job icons in the RIP area are described below: 

After a job is rasterized, it goes into the RIP area. The RIP area holds only raster data 
(i.e., jobs that have been rasterized). Jobs in the RIP area are either waiting for the 
copier to be free (Print queue jobs, icon 2 in the above table), or they are being held. 

RIP area icon: What it indicates: How long you see the job:

1

Yellow raster icon 
Yellow job row

Raster data, no destination 
defined; may have been 
printed before and held

Until it is deleted, moved to 
the Archive window, or 
stripped of its raster data and 
sent to the Spool area

2

White printer icon 
White job row 

Raster data headed for Print 
in its turn; no hold defined

Until copier is free to print 
the job
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Held jobs in the RIP area have already been rasterized (RIP and Hold) or they have 
been printed and their raster data has been routed back to the RIP area (Print and 
Hold), where they are shown in yellow rows (icon 1).

NOTE: Raster jobs in the RIP area that are waiting to print (icon 2 in the previous table) 
cannot be manipulated by job commands.

Jobs held in the RIP area remain there until the operator moves them to the Archive 
window or deletes them. Printing these jobs does not remove them from the RIP area. 
Instead, a copy of the job is created and printed.

NOTE: For all rasterized jobs, the print option settings, in addition to the current 
calibration state of the Fiery X3e, remain with the saved raster data each time the job is 
reprinted. To print the job with new print option settings and with new calibration 
data, you must remove the raster data and reRIP the job.

Print area
The job icons in the Print area are described below:

The Print area, also referred to as the Printed queue, contains jobs that have already 
been printed. These jobs were assigned the Print destination (white printer icon in the 
Spool or RIP areas) without any Hold instructions; therefore, they all have white icons 
and rows.

NOTE: A job row that appears in light red indicates that a PostScript error occurred 
while printing the job. To see the error, double-click anywhere in the row.

Print area icon: What it indicates: How long you see the job:

1

White printer icon 
White job row 

PostScript data only—raster 
data has been deleted

Until the job limit is reached

2

White raster icon 
White job row 

Raster and PostScript data

If RAM is needed to RIP an 
active job, the raster data is 
deleted and the job gets the 
PS icon (icon 1, above)

Until the job is reprinted or 
the job limit is reached
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Newly printed jobs are added to the Printed queue, and are shown at the top of the list. 
Jobs are saved in the Printed queue until the job limit is reached. When the first job 
over the limit is printed, the oldest job is deleted from the disk. The value for Jobs 
Saved in Printed Queue can be changed in Fiery X3e Setup by the administrator.

NOTE: If you reprint a job in the Printed queue, the job returns to its original position 
in the Printed queue after it is printed.

While it is printing, a job consists of PostScript and raster data. The raster data in 
RAM is not cleared until memory is needed to rasterize the next job. As long as the 
raster data is intact, the job can be reprinted from the Printed queue. Printed jobs that 
still have their raster data are represented by a white raster icon in the Printed queue 
(icon 2 in the previous table); jobs with only PostScript data remaining are represented 
by a white PS icon (icon 1). If the job was printed from a held raster job (in the RIP 
area), the raster data in the RIP area remains and can be used to reprint the job after 
the raster data has been cleared from the Printed queue.

Job commands
Job commands are used to assign a selected job to a new destination or process. These 
commands are available from the Job menu (see page 2-8). Many are also available as 
right-mouse commands (described following the list of commands below). The job 
commands available at a given time depend on the context; unavailable commands are 
dimmed. Job commands are available in the Queues and Archive windows.

The job commands available for selected jobs in the Queues and Archive windows are 
listed in the following table. The table also describes the effect of each command on 
raster data associated with the affected job(s).

Choose this: To do this: Raster data is:

Delete Delete the job(s) Deleted

Duplicate Duplicate one or more selected PostScript 
data jobs in the Spool or Print areas. You 
can use the duplicate job(s) for different 
print options or a different destination. 
(The Duplicate command actually creates 
a reference to the original job, with the 
same name)

n/a
(The Duplicate command is not available for 
raster jobs)
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Rename Rename the job (PostScript file with or 
without raster)

Unaffected, but associated with the new name

Hold Hold the job in the current place (except 
for a job in the Print area, which is moved 
to the Spool or RIP area, depending on 
whether it still has raster data associated 
with it)

Held in RIP area, if included with job

RIP and Hold RIP the job and hold it in the RIP area Held in RIP area indefinitely

Print Print the job in its turn (RIP it first if it 
does not have raster data)
After printing, keep the printed job in the 
Print area until the job limit is reached

Temporarily held in RAM after printing until 
memory is needed for another job
(If the job was printed from a held job in the 
RIP area, the raster data in the RIP area is kept 
indefinitely)

Print and Hold
(Like the user print option 
Save Fast Reprint)

Print the job in its turn (RIP it first if it 
does not have raster data) 
After printing, hold the PostScript data 
and the raster in the RIP area

Held in RIP area indefinitely (saved to disk)

Process Next Give top priority to this job
RIP (and then print) it as soon as the 
processor is free, before other waiting jobs
Option is dimmed if there are no other 
waiting jobs

n/a

NOTE: This command is available only for 
jobs in the Spool area that are not currently 
held.

Remove Raster Remove the raster data from a job that has 
raster data (indicated by a raster icon); 
leave the PostScript data unaffected

Deleted

NOTE: If you remove raster from a job in the 
RIP area, the job is sent to the Spool area.

Properties View, override print option settings, and 
print a selected job or a group of selected 
jobs

Possibly deleted and regenerated, depending 
on whether you change any settings that 
require re-RIPping

Thumbnail A n/a n/a

Thumbnail B n/a n/a

Download Download files and fonts to the Fiery X3e 
with Fiery Downloader; see page 3-14

n/a

Choose this: To do this: Raster data is:
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Using right-mouse commands 

Use the following instructions to activate job commands with a single right-mouse 
click.

TO ROUTE JOBS WITH RIGHT-MOUSE  COMMANDS:

1. To route a single job in the job list, right-click the job.

2. Select one of the commands or destinations and release the mouse button.

The command is carried out or the job is routed to the destination you chose. 
Depending on your choice, the job line may reappear in a different part of the window 
or a different window, or the job line may be deleted.

3. To route multiple jobs at the same time, select the jobs first. 
Click the job line to select the first job. Shift-click to select adjacent jobs; 
Ctrl-click to select nonadjacent jobs.

NOTE: Select jobs with the same job icon; otherwise, the destination options may not 
be the same. For example, select multiple jobs in the Spool area, and choose Print.

4. With the cursor still in one of the selected job lines, press the right mouse button.

5. Select one of the commands or destinations and release the mouse button.

The command is carried out or the jobs are routed to the destination you chose.

Archive Archive the selected held job(s) to the 
Fiery X3e hard disk, a device on the 
network, or to the local Command 
WorkStation hard disk, and move the job 
icon to the Archive window; see page 2-24

Archived with the job, if archiving of raster 
data is specified

Import Import PostScript or raster data jobs 
previously archived to external volumes; 
see page 3-22

Imported with the job, if it is available

Send 
to<Nickname_Devicename>

Transfer the selected job(s) to another 
currently connected Fiery X3e; see 
page 3-19

Transferred with the job

Choose this: To do this: Raster data is:
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Archive window
If you want to store jobs before or after printing them, you can archive them. The 
Fiery X3e can archive jobs internally on the Fiery X3e hard disk and externally on the 
Command WorkStation hard drive or on network drives. For instructions on how to 
archive jobs, see page 3-20.

NOTE: The Archive window is not available if you logged in as Guest.

Both PostScript and raster data jobs can be archived, but jobs must first be held in the 
Spool or RIP areas of the Queues window before they can be archived.

When you archive a job, the job is moved, not copied, to the archive destination (the 
Fiery X3e archive area or the external device). The Archive window shows a cumulative 
list of all jobs that have been archived. This list is cleared (along with all jobs on the 
Fiery X3e) by choosing Clear Server on the Fiery X3e Control Panel (see page 1-5) or 
by using the Clear command from the Command WorkStation (see page 2-10).

The job icons in the Archive window are described below:

The job commands described on page 2-21 can also be used with jobs in the Archive 
window.

Archive icon: What it indicates:

Printer icon

PostScript data only—raster data not present or deleted

Job was archived from the Spool area

Raster icon 

Raster and PostScript data

Job was archived from the RIP area
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The icons that appear in the Archive window are always white, since they have no 
destination (as long as they are in the Archive window). 

By default, the Archive window displays all archived jobs. Until they are deleted, 
archived jobs remain in the Archive window indefinitely. You can display a subset of 
archived jobs based on various selection criteria by using the Filter command (see 
page 2-28).

For jobs archived to external devices, the Volume column shows the volume and 
pathname of the device. For jobs that were archived to the Fiery X3e hard disk, the 
Volume column is blank. 

As with the Queues window, you can select the headings for the display and use Job 
menu or right-mouse commands; you can also sort jobs.

To: Do this:

Sort jobs in a category, such as 
by Date

Double-click the Date/Time heading. A small arrow indicates whether jobs are sorted in 
ascending or descending order. Double-click again to sort in the reverse order.

Route a job to a destination in 
the Queues window

Use job commands from the Job menu or the right-mouse command menu. For example, to 
print a job, choose Print or Print and Hold. You can also select and route multiple jobs. For 
details, see page 2-23.
The other options, RIP and Hold or Hold, send a copy of the job to the Queues window (to 
the RIP and Spool areas, respectively) without printing it; Remove Raster (which applies 
only to jobs with the raster icon) leaves only the PostScript data for the job in the Archive 
window.

View only particular jobs Choose Filter from the Window menu, and make entries in the Filter dialog box (see 
page 2-28).

Delete a job Select the job(s) and choose Delete from the Job menu or right-mouse command menu.

Sort order indicator

External volume
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Job Log window
The Job Log is a list of processed and printed jobs, the date and time they were 
processed or printed, and the characteristics of the job. It includes downloaded files 
and fonts and RIP and Hold jobs.

NOTE: The Job Log window is not available if you logged in as Guest.

At any given time, the Job Log includes only those jobs processed or printed since the 
Job Log was last cleared. The Job Log can be cleared manually by choosing “Clear Job 
Log” from the Server menu or automatically if the administrator has enabled 
autoclearing of the Job Log in Setup. The Job Log is also cleared by choosing Clear 
Server on the Fiery X3e Control Panel (see page 1-5) or by using the Clear command 
from the Command WorkStation (see page 2-10). 

You can adjust the column widths in the Job Log display by clicking the column 
border in the heading and dragging left or right. For more information, see Chapter 3.

Display or move job ticket 
information headers in the 
Archive window

Click the right mouse button on the appropriate column head; choose Add from the 
drop-down menu to list the columns that you can add to the display. The categories are the 
same as in the Queues window (see page 2-13) but you can arrange them differently. The 
column head arrangements you set in the Archive window are independent of those you set 
in the Queues window. 

Adjust the width of a column Click the column border in the heading and drag left or right.

Export the currently displayed 
list of archived jobs to a 
tab-delimited text file

Choose Export from the Window menu. Specify a filename (the default name is archive.log) 
and a location for the file and click Save. You can then open the exported file with a 
spreadsheet, database, or word-processing application.

To: Do this:
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When you open the Job Log, you can choose to display all jobs in the current Job Log 
or only the jobs in a specified date range. By default, all jobs are displayed. To specify a 
date range, choose Filter from the Window menu, click Range, and enter dates in the 
From and To fields; or, click the calendar icons next to the From and To fields and 
select dates by clicking them in the calendars. Use the arrows at the upper corners of 
the calendars to display different months.

NOTE: In the Job Log window, “Start Time” reflects the time that the job began 
RIPping; “End Time” reflects the time that the job printed; and “Process Time” reflects 
the total RIP time for the job. These times do not correspond to the Date/Time values 
displayed in the Queues window.

Updating the Job Log display  To update the Job Log window display after specifying 
a date range (or at any other time), choose Refresh from the Window menu.

Exporting the Job Log  From the Job Log window, you can export the Job Log to a 
tab-delimited text file (the default name is job.log) by choosing Export from the 
Window menu. The exported file can be opened with a spreadsheet, database, or word 
processing application. The exported Job Log contains the jobs for the date range you 
specified.

Clearing the Job Log  The Job Log is stored on the Fiery X3e disk. When logged in as 
Administrator, you can clear the Job Log by choosing Clear Job Log from the Server 
menu. The Job Log is cleared whenever an Administrator clears the Fiery X3e or 
installs new software. In addition, the Job Log can be cleared automatically after every 
55 jobs.

Printing the Job Log  To print the Job Log, choose Print Pages from the File menu, 
select Job Log, click Print, and click OK. The Job Log is sent to the Print queue and 
then prints to the Fiery X3e. You can use Job menu commands to manipulate the Job 
Log print job as you would any other job. The printed Job Log contains the jobs for 
the date range you specified. See “Using the Job Log” on page 3-24 for more 
information.
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Printing and clearing the Job Log automatically  You can decide how you want to 
handle the Job Log. If you have Administrator privileges, you can choose Setup from 
the Server menu and enter your preferences in Job Log Setup. You can choose to print 
the Job Log automatically every 55 jobs, or both print and clear the Job Log 
automatically every 55 jobs. You can also choose the Job Log page size.

Filtering jobs
The Queues, Archive and Job Log windows displays a cumulative list of all jobs. If a 
large number of jobs are listed, it may be difficult to locate a particular job or a 
particular group of jobs. You can display a specified subset of jobs by filtering jobs in 
the Queues, Archive, and Job Log windows.

To open the Filter dialog box, choose Filter from the Window menu.
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In the Queues window, you can filter jobs according to any or all of the following 
criteria:

• Job title

• User name

• Date created (or a date range)

• Notes 1 or Notes 2 

• Instructions 

In the Archive window, you can filter jobs according to any or all of the following 
criteria:

• Job title

• User name

• Date created (or a date range)

• Notes 1 or Notes 2 

• Instructions 

• Volume

• Device

In the Job Log window, you can filter jobs by date only.

The Filter command lets you perform a search based on any and all values you specify 
in the Filter dialog box. Enter values in all fields relevant to your filtering criteria. If 
you enter values in more than one field, only jobs that meet all the criteria are 
displayed. For example, if you enter 10 in the Job Title field and <UserName> in the 
User field, only those jobs whose titles somewhere contain “10” and whose User name 
contains “<UserName>” will be displayed.
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To filter by date, select Range in the Date created area and enter dates in the From and 
To fields; or, click the calendar icons next to the From and To fields and select dates by 
clicking on them in the calendar that appears. Click the arrows at the upper corners of 
the calendar to display different months.

Creating Filter templates

If you often filter jobs according to specific criteria, you can create a filter template. In 
this way, you can filter jobs easily in one step and avoid the need to enter specific 
information each time you want to filter jobs.

TO CREATE A FILTER TEMPLATE:

1. Open the Filter dialog box by choosing Filter from the Window menu.

2. Enter specific job filter criteria in the appropriate fields.



22-31 Job properties
3. Click Save As.

4. Enter a name for the new template and click OK.

The new template is saved in the Templates pop-up menu in the Filter dialog box.

To view jobs in the Queues, Archive, and Job Log windows according to a filter 
template, open the Filter dialog box, choose the template by name from the Templates 
pop-up menu, and click OK.

To delete an existing template, open the Filter dialog box, choose the template by name 
from the Templates pop-up menu, and click Delete. Click OK to confirm that you 
want to delete the template.

Job properties
When logged in as Operator or Administrator at the Command WorkStation, you can 
use the Properties command to check and override the print option settings 
(properties) of all jobs. 

You can use this command for several purposes:

• To check a user’s job settings, especially notes and instructions

• To override a setting based on printed output or other print device conditions

• To change settings for a duplicate of the original job

• To print a single copy of a job before printing the number of copies required by the 
user
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Viewing and editing job properties
The Properties command lets you view, edit the print option settings of, and print 
multiple jobs simultaneously. You can use this feature to compare the properties of 
several jobs and thereby group together jobs with similar settings.

To view the properties of one or more jobs, select the job(s) and choose Properties from 
the Job menu or the right-mouse menu.

For information on using the Properties dialog box to change job settings, see 
“Viewing and overriding print settings” on page 3-11.

NOTE: Some print options that are available in the printer driver are not displayed in 
the Properties dialog box. For information on specific print options and settings, and 
where they can be set, see Appendix A of the Printing Guide.
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This chapter provides some general information about managing printing with the 
Fiery X3e and the copier, and gives you some hints on using the Command 
WorkStation windows to monitor and manage print jobs. It suggests ways to guide 
users so that their jobs print correctly the first time. The chapter also follows the course 
of a print job and shows possible ways to expedite jobs and take advantage of the 
special capabilities provided by the Command WorkStation.

Communicating with users
The Command WorkStation interface facilitates communication between users and 
operators. All the same, users who originate print jobs may need to become better 
informed about the Fiery X3e and the copier so they can choose the appropriate 
options for their jobs.

What the user needs to know
You or the network administrator should consider supplying the following information 
to your users:

• The name of the printer on the network and the names of servers sharing the printer

• User’s access status 

Do all jobs require operator intervention because they go to the Hold queue? If not, 
which connections are published—Direct connection and/or Print queue?

• How long you will hold jobs on the server before you delete them

• List of default printer settings and other settings (from the Configuration page)

• List of installed fonts

Do the users’ applications download fonts automatically? If not, should users embed 
fonts in documents, or should they supply fonts to the administrator so he or she 
can download them? 

Chapter 3:
Managing 
Print Jobs



33-2 Managing Print Jobs
• Requirements for Notes fields (information which appears in the Job Log)

For example, department name, account code, phone number or extension. Is some 
information mandatory at your site?

• Resident calibration target and date of current measurements

• Custom simulations

Are they available? What type of targets do they represent? Users see these print 
options (CMYK Simulation) and should not select them if there are no custom 
targets on the server.

• IP address or DNS name of printer so users can access Fiery WebTools to determine 
whether their jobs have printed

• Installed option(s)

• Available media, alternative choices, standard tray/media configurations

• Suggestions for the Instructions field

• Information users might find in the WebLink web site

• Instructions for setting up the printer on client computers

• Sources of PostScript printer drivers, PPDs, color reference files, and additional 
information

• Recommended PPD settings

• Conflicting settings and common PostScript errors
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How users communicate print requirements
Explain to remote users the information you check and what you need to know in 
order to print the jobs they send. The Instructions field is suited for communication 
about the job requirements. Notes fields appear in the Job Log so they are more suited 
for accounting, billing, and job cost information. 

Users can provide you information with the print job, for example:

• Information entered in the Instructions field or the Notes fields—special 
requirements at your site (see below)

• Job ticket information provided by PPD option settings (job properties)

Instructions and Notes fields

• User name and phone number

• Priority, due date, request for notification

• Number of copies needed

• Request that operator do color check

• Hold job for future printing or future reprinting

• Merge with another job, and merging instructions

• Quantity of paper required

• Future requirements for the job
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Customizing the Command WorkStation window
You can customize the display of job ticket information in the Queues window by 
rearranging the column headings. You can tighten the columns, add new column 
headings, move columns, and delete column headings. 

NOTE: The Job Title and User columns are always at the left and cannot be moved or 
deleted. You can only add column headings to the right of the User column.

TO CUSTOMIZE THE QUEUES WINDOW DISPLAY:

1. Right-click in the column heading.

A menu appears. The Add submenu lists the headings that are not already displayed.

2. Choose the options you want to display and the sequence in which you prefer to view 
them.

Add, delete, or move a column by holding down the right mouse button on the name 
of the appropriate column heading; release the button after choosing one of the menu 
options:

Add one of the listed columns to the display at your mouse position.

Move Left, Move Right—move the selected column left or right.

Delete the selected column.

The Job Title and User columns are required—all others are optional.

3. Adjust the column widths. 

Adjust the width of a column by clicking the column border in the heading and 
dragging to the left or right. You can change the column widths at any time.

If you display the Instructions column, which shows information typed into the 
Instructions field by the user, you can reduce the width of the column so you can just 
see whether or not there are instructions in it. 

4. With a narrow Instructions column, if you want to read detailed instructions, double-
click the job and choose Notes from the Job Properties window. 

This also allows you to read the notes. You can edit or annotate the information in the 
Instructions field if you wish. It remains with the job as long as the job is on the server. 
The operator cannot edit the Notes fields.
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Setting Command WorkStation Preferences
Choose Preferences from the File menu to access the Preferences dialog box.

Menu: Choose this: To do this:

Preferences\
General

Enable Animation Turn on or off animation of the status bars

Enable Popup Help Turn on or off short captions that appear when you 
pause the mouse over window elements; the 
captions identify the main parts of the Command 
WorkStation window

Units Specify the type of unit (Points, Inches, or 
Millimeters) to use in the display for custom page 
sizes

Temporary path Specify a location for temporary files created by the 
Command WorkStation application
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Printing Fiery X3e information pages
Using the Print Pages command, you can print system pages stored on the Fiery X3e.

1. Choose Print Pages from the File menu.

2. In the Select Printer area, specify where you want to print the pages.

Server—The pages you specify are printed to the Fiery X3e.

Local Printer—The pages you specify are printed to any selected printer installed on 
your Windows computer.

Preferences\
Filter

Helper Application Specify the path to a helper application from which 
to view data in the active window; this application 
opens automatically when “View in Helper App” is 
chosen from the Window menu

Template path Specify the path to where Filter template files are 
saved; for more information on Filter templates, see 
page 2-30

Menu: Choose this: To do this:
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3. If you specify Server, select from the following pages:

PS Test Page—A Test Page enables you to confirm that the Fiery X3e is properly 
connected to the copier, and provides color and grayscale samples to troubleshoot 
problems with the copier or the Fiery X3e. The following settings are among those 
listed on the Test Page: Server Name, Printer Model, color settings, calibration 
information, date and time the Test Page was printed.

Configuration—Prints the Configuration page, which gives the current server and 
device configuration. This page lists general information about the hardware and 
software configuration of the Fiery X3e, the current settings for all Setup options, 
information about the current calibration, and the Ethernet addresses of the Fiery X3e. 

Job Log—Prints a log of the last 55 jobs processed or printed. For information on the 
fields in the Job Log and on printing it in other forms, see “Using the Job Log” on 
page 3-24.

Control Panel Map—Prints the Control Panel Map, which is an overview of the screens 
you can access from the Control Panel. For information about using these screens to 
set up the Fiery X3e, see the Configuration Guide.

Color Charts—Prints samples of the RGB, CMY, and PANTONE colors available from 
the Fiery X3e. 

PS Font List—Prints a list of all fonts currently resident on the Fiery X3e hard disk.

If you specify Local Printer, select from the following pages:

Configuration—Prints the Configuration page, which gives the current server and 
device configuration. This page lists general information about the hardware and 
software configuration of the Fiery X3e, the current settings for all Setup options, 
information about the current calibration, and IP address of the Fiery X3e. 

Archive Log—Prints a log of all archived jobs.

Queues—Prints a log of all jobs in the Queues window. 

NOTE: The number of jobs listed under the Print area of the Queues log is specified in 
Server Setup. For more information see the Configuration Guide.
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4. Click Print.

5. If you selected Server in step 2, specify the number of copies to print and click OK.

The page(s) are printed to the Fiery X3e.

If you selected Local Printer in step 2, choose the desired printer in the Print dialog 
box, specify the number of copies to print, and click OK.

The page is printed to the printer you specified.

NOTE: Server information pages printed with the Print Pages command appear in the 
Fiery X3e Job Log with a User Name of “Operator” even if you logged in as 
Administrator.

Workflow scenarios
The workflow at your site will depend on the number and complexity of jobs and the 
amount of responsibility given to the operator. This section suggests some ways you 
might interact with a job.

Scenario 1 At this site, the Print queue is enabled, and anyone using the Command 
WorkStation can view the progress of jobs. You watch the job progress from the top to 
the bottom of the Queues window.

The green light on the copier flashes, the network icon blinks; on the Command 
WorkStation the Spool status bar is animated and the job title appears. As soon as 
spooling has finished, the Spool status bar is cleared and the RIP status bar animates. 
Almost immediately thereafter, the RIP status bar is cleared and the Print status bar 
animates. The printed job is listed below the Print status bar and the job pages emerge 
from the copier.

Scenario 2 At this site, all jobs come to the Hold queue and therefore require 
operator intervention to proceed.

Again, the green light on the copier flashes, the Spool status bar is animated, and now 
in the Spool area (below the status bar) the job title comes into view. In a few moments 
the job is on the list, and you have time to scan the headings for the job ticket 
information—media type, special instructions, copies, and pages.
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Are you ready for this job to print? Do other jobs have priority? What is the job for—
is it final output or a test print? The first choice is whether to put the job in the print 
queue or hold it before processing it further. If you do nothing, the job remains in the 
Spool area, and the file remains on the server disk.

Perhaps this is a routine job and does not call for special handling. You right-click the 
job and choose Print. You notice the RIP status bar animate, and almost immediately, 
the Print status bar animates. The printed job is listed below the Print status bar and 
the job pages emerge from the copier.

The next job is a large job that you have not seen before. The Instructions field 
indicates that the originator of the job wants to check one printout of the job before 
you print another 50 copies. You make sure the Copies field is set to 1, right-click the 
job, and choose Print and Hold.

The RIP status bar animates and displays the job title, and then the Print status bar 
and copy 1 of the job emerges from the copier. You call the sender of the job for 
approval. When the job is approved, you set the number of copies to 50, right-click the 
job now being held in the RIP area and choose Print.

Scenario 3 Everyone has discovered the copier on the network and jobs are coming in 
rapidly. You right-click several routine jobs in the Spool area and choose Print to let the 
server print them one after the other. You choose Print and Hold if you know you will 
be reprinting the job soon. You move jobs that have more detailed instructions (or 
need to be printed with similar jobs) to the Archive window (right-click Archive). You 
remove printed jobs from the output trays and replenish media. 

While some jobs are flowing through the queues and printing, you are preparing for 
jobs that require more attention, such as obtaining special paper or notifying the 
originator of a job that a PostScript error occurred. 

Before you load special paper, you make sure all pending jobs are in holding areas. 
When an especially important job is spooled for RIPping, you right-click Process Next. 

You flip back and forth between the Archive and Queues window. You use the Archive 
window to sort jobs into groups with similar requirements, such as media type, user 
name, or another setting, and print all the jobs of the same type in sequence.
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Using the copier
If you have a copier job that has priority over the spooled incoming print jobs you can 
temporarily close the Fiery X3e connection to the copier and then reopen it when you 
have finished copying.

When there are no active printing jobs competing for the copier engine (no white job 
lines in the Spool or RIP area), you do not need to suspend printing to make copies.

TO GIVE THE COPIER TOP PRIORITY AND LATER RESTORE FIERY X3E PRIORITY:

1. From the Server menu, choose Suspend Printing, press the F5 key, or right-click the 
Print status bar and choose Suspend Printing. 

This suspends printing temporarily. Jobs continue to spool and RIP on the server as 
long as disk space and RAM are available. 

2. When you have finished with the copier job, choose Resume Printing from the Server 
menu, press the F6 key, or right-click the Print status bar and choose Resume Printing.

The printing connection between the Fiery X3e and the copier is reopened and 
printing resumes.

Using the copier as a scanner
With Scanner Mode you can scan an image from the copier glass or from the 
Duplexing Document Feeder to the Fiery X3e, then open the image with WebScan. 

Scanning with Fiery Scan requires that you place the original on the copier, and that 
you run Photoshop from a networked workstation. In a high-volume printing 
environment, however, remote users who want to scan might have to wait for a 
connection to the Fiery X3e. Under those circumstances you or another operator may 
prefer to take over the scanning function. Ideally, you would set up a networked 
workstation near the copier and run Photoshop. From this workstation you can scan 
jobs for users in the slow printing times. For more information about scanning, see the 
Printing Guide.
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Canceling jobs
You may need to cancel a job after it has been routed for processing or printing. You 
can cancel a job only while it is being RIPped or while it is being printed. You cannot 
cancel a waiting job (white job row) that is routed for RIPping or printing. 

• Canceling jobs during processing—While a job is being RIPped, and its name 
appears in the RIP status bar, choose the Cancel RIPping command from the Server 
menu, press the F7 key, or right-click on the RIP status bar and choose Cancel 
RIPping. 

When the RIP job is canceled, the Canceling message appears in the RIP status bar 
and on the Fiery X3e Control Panel. The name of the canceled job appears in the 
Job Log.

• Canceling jobs during printing—While a job is printing, and its name appears in 
the Print status bar, choose the Cancel Printing command from the Server menu, 
press the F8 key, or right-click on the Print status bar and choose Cancel Printing. 

When the print job is canceled, Canceling appears on the Fiery X3e Control 
Panel.The name of the canceled job appears in the Job Log. 

NOTE: Canceled jobs may be partially printed, and may include pages with one or more 
missing color planes, or pages that are completely blank.

• Canceling at the Control Panel—If you are at the Fiery X3e, the most direct way to 
cancel a job is to press the Cancel button on the server Control Panel while you can 
read the name of the job that is processing or printing. For more information on the 
Control Panel, see Chapter 1.

Viewing and overriding print settings
When logged in as Operator or Administrator at the Command WorkStation, you can 
view override user job settings for, and print any job in the Queues window. Using the 
Properties dialog box, you can view and override job settings for a single job or for 
multiple jobs at once. When viewing multiple jobs, you can override settings for each 
job independently or override a setting for all the jobs at once.
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• To view the properties for a single job, double-click the job line or select the job and 
choose Properties from the Job menu or right mouse menu.

• To view the properties for multiple jobs at once, shift-click to select contiguous jobs, 
or Ctrl-click to select non-contiguous jobs, and choose Properties from the Job 
menu or right mouse menu.

NOTE: If you want to retain a copy of the job with its original settings, duplicate the job 
and rename the duplicate before you change any settings (see “Job commands” on 
page 2-21). 

To override a setting for a single job, right-click on the current setting and choose the 
override setting from the pop-up list.

NOTE: For some options, changing the setting requires that the job be reRIPped; these 
options show an icon to the left of the option name.

Indicates reRIPping is required
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To override settings for all jobs listed in the Properties dialog box, right-click on the 
name of the print option (the row header) at the left of the dialog box and choose the 
override setting from the pop-up list.

The Properties dialog box displays all the job settings encoded by the PostScript printer 
driver that can be decoded by the Fiery X3e. If you (as operator) have not changed 
anything, these are the settings a user entered before sending the job. There are two 
exceptions to this: Page Range and Scale

NOTE: Some print options that are available in the printer driver are not displayed in 
the Properties dialog box. For information on specific print options and settings, and 
where they can be set, see Appendix A of the Printing Guide.

When the Properties dialog box opens, the page range is always shown as All pages and 
the scale is always shown as 100%. All pages denotes all the pages specified by the user 
in printing the job; it may not include all the pages in the original document on the 
user’s disk. Similarly, 100% scale indicates 100% of the magnification specified by the 
user.
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The Properties dialog box does display all the remaining user settings, including user 
Instructions and Notes fields. 

• Instructions fields are intended to be viewed and annotated by the operator, but 
their contents are associated with the job and are deleted when the job is deleted 
after printing. 

• Notes fields can be viewed but cannot be changed by the operator; their contents are 
transcribed to the Job Log just as the user sent them.

Downloading files and fonts
From the Command WorkStation you can download a variety of file types, as well as 
fonts, to the Fiery X3e. These files and fonts can be located anywhere on the network 
or on an external device connected to the Command WorkStation computer. You 
browse to locate the files and fonts, select them, and add them to a list of items to be 
downloaded. You can specify a limited number of print option settings for files that 
you download (see page 3-16).

To download fonts, the Direct connection must be used. If the Direct connection is 
not currently published in Setup, see the Configuration Guide for instructions on how 
to publish it. 

NOTE: You cannot download TrueType fonts. If you use TrueType fonts in Windows, 
you can print them by converting them to Adobe Type 1 fonts. To do this with the 
Adobe PS printer driver, click the Fonts tab and set up the Font Substitution Table as 
necessary.

The Manage Fonts command (in the Server menu) provides another way to download 
fonts to the Fiery X3e (see page 3-17).
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TO DOWNLOAD FILES OR FONTS:

1. Choose Download from the Job menu, right-click the Spool status bar and select 
Download, or open the utilities slider and click the Downloader icon. 

The main Fiery Downloader window appears.

2. In the Files of type pop-up menu, choose the file types to display.

You can leave this at the default All Known Formats or choose All Files. All Known 
Formats lists all files in supported formats; All Files lists all files.

3. In the Connection Type pop-up menu, choose the queue to which you will download 
the files.

The options available in this menu depend on the print connections currently enabled 
in Setup. The potential choices are Print Queue, Hold Queue, or Direct Connection. 
If your administrator has not enabled one or more of these connections, you cannot 
choose it.

To download fonts, you must choose Direct Connection.

For fonts, choose Direct 
connection
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PDF files are always spooled to the Fiery X3e hard disk before being printed. PDF files 
must be sent to the Print queue (or to the Hold queue if the Print queue is not 
enabled). Do not choose Direct Connection to download PDF files.

4. In the Look in pop-up menu, browse to the file(s) you want to download.

5. Select the filename and click Add.

The File name field displays the name of the selected file before you click Add.

You can navigate to different drives and directories to select files and fonts to 
download. 

To select multiple sequential files, select the first file and then Shift-click the last file. 
Ctrl-click to select multiple non-sequential files.

If you change your mind about a file, select the filename in the Files to be Downloaded 
list and click Remove.

6. To change the attributes of a file, select it from the “Files to be Downloaded” list and 
click Options.

The Options dialog box for PostScript and EPS files is different from that for PDF 
files, as explained below. 

7. Specify the following information in the dialog box and click OK.

The options you set apply only to the selected file. You can set different options, or 
leave the default settings, for each file.

Copies—Specify the number of copies.

PostScript options PDF options
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Brightness (PostScript and EPS files only)—Change the Brightness setting if a file 
appears to be too dark or too light. Choose 85% for a substantially lighter image, 
115% for a substantially darker image, or one of the options in between. 

NOTE: Some applications, including Adobe Photoshop, provide transfer functions that 
let you specify density settings for an image. If the file you are printing includes 
transfer functions, the Brightness option has no effect. For more information on using 
transfer functions, see the documentation for your application.

‘showpage’ (after EPS files)—In most cases, you do not need to use this option. Select 
this option only if an EPS file fails to print without it. This option adds a ‘showpage’ 
PostScript language command at the end of the print job. Some applications omit this 
necessary PostScript language command when they generate EPS files. Select this 
option when printing EPS files generated by these applications. If you select this 
option unnecessarily, extra blank pages may print.

If you experience problems downloading EPS files, you can print the file directly from 
the application in which you created it.

Page Range (PDF files only)—Specify the page range you want to print.

8. Click Download.

To cancel downloading, click Cancel or press the <Esc> key.

Managing server fonts
The Fiery X3e includes a number of built-in printer fonts. You can download 
additional fonts to the Fiery X3e using the Manage Fonts command (see page 3-18) or 
the Download command (see page 3-15). Users on the network can also download 
fonts to the server using Fiery Downloader (see the Printing Guide). Downloading 
fonts, either from the Command WorkStation or with Fiery Downloader, requires that 
the Direct connection is published in Setup (see the Configuration Guide).

NOTE: The Manage Fonts command is available only if you logged in as Administrator.

Although no special privileges are necessary to download fonts, Administrator 
privileges are required to remove fonts from the server. The built-in printer fonts are 
locked and cannot be removed by anyone.

To print a list of fonts currently resident on the Fiery X3e, use the Print Pages 
command (see page 3-6). 
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TO ADD OR DELETE FONTS:

1. Choose Manage Fonts from the Server menu.

The Server Fonts window displays Add, Delete, Update, and Print buttons.

2. To download additional fonts to the Fiery X3e, click Add and refer to the instructions 
on page 3-14.

3. To delete a font, select it in the font list and click Delete. Shift-click or Ctrl-click to 
select multiple fonts.

NOTE: The printer fonts included with the Fiery X3e (built-in fonts) are locked. These 
fonts appear with a lock icon next to the name and cannot be deleted.

4. To refresh the font list display, click Update.

5. To print the font list, click Print.

Click to update the font list display

Click to delete font(s)
Locked fonts

Click to download additional fonts

Downloaded fonts
Click to print the font list
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Managing jobs with multiple color servers
You can connect to up to five Fiery X3e color servers simultaneously from the 
Command WorkStation. This allows you to view and manage jobs being processed by 
multiple servers from a single location, and also to balance the job load between servers 
of similar capabilities.

• If you connect to multiple servers from the Command WorkStation, you can easily 
switch between them by clicking the server selection tabs (see page 2-10). 

• With Fiery X3e color servers that support the feature, you can use the Send 
to <Nickname_ Devicename> command to transfer jobs between color servers 
(see page 2-9). 

TO VIEW AND MANAGE JOBS ON MORE THAN ONE COLOR SERVER:

1. Configure the connection to the first server and log in. 

See Getting Started for information on configuring the connection to the server.

2. Click a blank server selection tab.

3. Configure the connection to the next server and log in.

The Command WorkStation windows show the job lists for the additional server. You 
can route and manage the jobs processed by this server as long as you are logged in.

4. To switch servers, simply click the other server selection tab. 

Once you have logged in, you do not need to log in again unless you have logged out.

If the servers are extremely busy with continuous jobs, you may see some delay in 
updating the Command WorkStation window when you switch between servers. Job 
lists may be blank for some seconds until updating is complete.
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TO TRANSFER JOBS BETWEEN COLOR SERVERS:

1. Log in to more than one color server, as described above.

To transfer jobs between color servers, both color servers must support the Send 
to <Nickname_Devicename> command. 

2. In the Queues window of the source color server, select the job(s) you want to 
transfer.

You can select any held jobs in the Spool or RIP areas.

3. Choose the Send to <Nickname_Devicename> command from the Job menu.

If two or more additional color servers (in addition to the originating server) are 
connected to the Command WorkStation, multiple Send 
to <Nickname_Devicename> commands appear in the Job menu. 

Jobs are transferred from the source server to the same area on the target server (from 
Spool to Spool, from RIP to RIP).

NOTE: You cannot perform any other Command WorkStation functions while files are 
being transferred between servers.

4. After verifying that the jobs were successfully transferred, you can delete them from 
the originating server, if you wish.

Archiving jobs
PostScript and raster data jobs can be archived internally to the Fiery X3e hard disk or 
the ZIP drive, or externally to the Command WorkStation hard disk or network 
drives.

TO ARCHIVE A POSTSCRIPT OR RASTER JOB:

1. In the Queues window, select any held job in the Spool or RIP areas.

2. Choose Archive from the Job menu.

The job is moved to the Archive window.
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3. To archive the job(s) internally to the Fiery X3e hard disk or to the ZIP drive, click OK.

The job(s) are archived internally.

4. To archive the job(s) externally to the Command WorkStation hard disk or to a device 
on the network, click Add.

5. Browse to the device and folder to which you want to archive the job(s) and click OK.

The Archive Options dialog box shows external devices as available archive volumes.

Click to add a device
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6. If applicable, select Archive rasters.

The Archive rasters option is automatically selected and dimmed for PostScript data 
jobs and for jobs being archived to Server Internal.

NOTE: Raster data files may be large and therefore may take considerable time to 
archive. In order to save time and disk space, archive PostScript data jobs only.

7. Select an archive volume and click OK.

To retrieve jobs archived to external devices, use the Import command.

Importing archived jobs from external media
You can use the Import command to find and retrieve jobs previously archived to 
external devices. This command can be used to retrieve files archived from the current 
Fiery X3e or from another Fiery X3e that supports external archiving.

TO IMPORT AN ARCHIVED JOB FROM AN EXTERNAL DEVICE:

1. Choose Import from the Job menu in the Queues window, or right-click on the Spool 
status bar and choose Import.

2. In the Directories area, select the device containing the job(s) you want to import.
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Click Add to import files from other archived volumes.

3. In the Job Title area, select the job(s) you want to import.

Shift-click to select multiple, adjacent jobs; Ctrl-click to select multiple, non-adjacent 
jobs.

4. Click OK.

The job is imported to the same area in the Queues window (Spool or RIP) from 
which it was archived.
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Using the Job Log
Chapter 2 introduced the Job Log, which is the list of all processed and printed jobs, 
including the date and time they were printed, and all the characteristics of the job. It 
explained that the Administrator can set Job Log preferences for clearing and printing 
the Job Log automatically, and for Job Log page size (page 2-27).

If you want to view the Job Log in a specific application, you can specify one in the 
Preferences dialog box (see page 3-5), then select View in Helper App from the 
Window menu.

After displaying the Job Log you can print it (use the Print Pages dialog box or choose 
Print from the Window menu), or export it to a tab-delimited text file (choose Export 
from the Window menu). The exported Job Log file can be imported into a 
spreadsheet, database, or word processing application for job accounting purposes. If 
the Filter command is used to display only a portion of the Job Log (such as jobs for 
the current day), only that portion of the Job Log is printed or exported.

To update the Job Log, choose Refresh from the Window menu.

After printing or exporting the entire Job Log, you may want to clear it; choose Clear 
Job Log from the Server menu.

The Job Log window displays a list of all the jobs and the following information about 
them: status, document name, user, date, start time, end time, process time, size, 
device, page size, media, number of originals, number of color pages, number of black 
and white pages, and total number of pages. Information in the Notes 1 and Notes 2 
fields is displayed if users entered this information when they printed.
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The text in the Status column provides information about the job: 

Use the scroll bar at the bottom of the window to view all the fields in the Job Log 
window.

Other server management commands
These additional Server menu commands are used to manage server performance, 
configuration, and status. Some of these commands are available only when logged in 
as Administrator:

• Manage Fonts—Allows you to delete fonts from, as well as add fonts to, the 
Fiery X3e (see page 3-17)

• Manage Color—Opens ColorWise Pro Tools (see the Color Guide) 

• Reboot—Causes the Fiery X3e to be rebooted, just as if you had selected Reboot 
Server from the Control Panel (see page 1-5)

• Clear—Clears all jobs in all server queues as well as all jobs archived on the Fiery X3e 
hard disk, the index of archived jobs (in the Archive window), and the Job Log

• Setup—Invokes Fiery Setup; for more information, see the Configuration Guide

• Log out—Closes the connection to the Fiery X3e, just as if you had chosen Log out 
from the log in/out slider

OK The job was printed normally.

Cancel The job was canceled before printing was completed.

Error An error occurred during processing or printing.
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This chapter introduces Fiery WebTools and provides instructions on their usage. For 
more information on certain Fiery WebTools you are referred to other chapters in this 
book and to other manuals in the documentation set.

Fiery WebTools
Fiery WebTools reside on the Fiery X3e but can be accessed over the network from a 
variety of platforms. The Fiery X3e has a home page that lets remote users view server 
functions and manipulate jobs. 

Fiery WebTools can be used on Windows 95/98/Me/NT 4.0 and 2000 client 
computers with certain Internet browsers that support the Java language. For specific 
information on the browsers supported with Fiery WebTools, see Getting Started.

Access privileges
The Fiery X3e system allows the site administrator to choose and implement a level of 
access and control appropriate for your particular site. There is a spectrum of control 
which can be implemented; the levels of access allowed to remote users depend on 
whether the administrator has enabled use of Fiery WebTools, and whether or not a 
password is required to use the job management features of Fiery WebTools. 

If you have been given the Operator password, you can manage job flow and override 
print settings of your jobs with Fiery WebSpooler. If not, you can still track the status 
of your jobs with the Status tool, and with Fiery WebSpooler as a Guest. Check with 
your site administrator for information on your Fiery WebTools access privileges.

Chapter 4:
Overview of 
Fiery WebTools
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Using Fiery WebTools
Fiery WebTools are accessed from the Fiery X3e home page.

WebTool: Summary: For more information:

Status Shows you the jobs currently processing 
and printing.

See the Printing Guide

WebSpooler Allows you to view, manipulate, reorder, 
reprint, and delete jobs currently 
spooling, processing, or printing on the 
Fiery X3e. It also allows you to view, 
print, and delete the Job Log.

See “Tracking and managing 
jobs with Fiery WebSpooler” 
on page 5-1

WebLink Provides a link to another web page, 
provided you have a valid Internet 
connection. The WebLink destination is 
initially set to www.efi.com. The 
WebLink destination can be changed; 
this function requires the Administrator 
password, if one has been set.

See the Printing Guide and 
the Configuration Guide

Installer Allows you to download Fiery X3e 
printer file installers directly from the 
server.

See Getting Started

WebDownloader Allows you to download files to the 
Fiery X3e.

See the Printing Guide

WebSetup Allows you to modify the Fiery X3e 
configuration (Setup) remotely. This 
function requires the Administrator 
password, if one has been set.

See the Configuration Guide

WebScan Allows you to view and print images that 
have been scanned to the copier.

See the Printing Guide
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TO ACCESS FIERY WEBTOOLS:

1. Start your Internet browser application. 

2. Enter the IP address or the DNS name of the Fiery X3e.

Check with the operator or administrator for this information.

The Fiery X3e home page appears.

3. Click one of the buttons at the left to select one of the Fiery WebTools.

Move the cursor over the buttons to display information about the selections.
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Fiery WebSpooler and Fiery Spooler are job management tools that duplicate many of 
the functions and features of the Command WorkStation.

NOTE: Fiery Spooler is available for Mac OS computers only.

• Fiery WebSpooler, one of the Fiery WebTools, is accessed with an Internet browser 
and the Fiery X3e home page (see Chapter 4). 

• Fiery Spooler is installed from the User Software CD. To use Fiery Spooler, users 
need only a network connection to the Fiery X3e.

The interface of Fiery Spooler for Mac OS computers is virtually identical to that of 
Fiery WebSpooler. Moreover, the interfaces of these tools are so similar to that of the 
Command WorkStation that this chapter often refers you to Chapters 2 and 3 (on the 
Command WorkStation) for information about icons and commands that is common 
to all three tools.

Tracking and managing jobs with Fiery WebSpooler
You can use Fiery WebSpooler (and Fiery Spooler for Mac OS) to perform the 
following functions from your workstation:

• Override current job option settings

• Delete jobs and cancel processing

• Duplicate or rename jobs

• RIP a job and hold the raster data

• Hold jobs in the spooled area or the RIPped area

• Remove raster data from RIPped files

• Change the priority of jobs

• Display, print, or delete the Job Log 

Most of these functions require the Administrator or Operator password. However, 
even without a password, you can log in to Fiery WebSpooler as Guest with view-only 
privileges.

Chapter 5:
Fiery WebSpooler 
and Fiery Spooler
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NOTE: Most Fiery WebSpooler commands function identically to those of the 
Command WorkStation. For more information on specific commands, see 
Chapters 2 and 3.

TO ACCESS THE FIERY WEBSPOOLER WINDOW:

1. From the Fiery X3e home page window, click WebSpooler.

For instructions on how to access the Fiery X3e home page window, see page 4-3. 

2. To log in as Administrator, enter the Administrator password and click OK.
To log in as Operator, enter the Operator password and click OK.
To log in as Guest, click OK, without entering any password.

The Fiery WebSpooler window appears in a new window.
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About the Fiery WebSpooler window
Like the Command WorkStation, Fiery WebSpooler is a window to view Fiery X3e 
and copier functions, and an interface from which you can control those functions.

The Fiery WebSpooler window is divided into three areas by Spool, RIP, and Print 
status bars. When the Fiery X3e receives print jobs, the Fiery WebSpooler window 
becomes a dynamic display, filled with the names of jobs and their characteristics.

The Spool, RIP, and Print areas of the Fiery WebSpooler window represent the stages 
of printing a job. Jobs come in at the top level (Spool) and drop down to the Print 
level, unless they are held along the way.

The job icons displayed in the Fiery WebSpooler window are explained in “Job icons” 
on page 2-18.

NOTE: In the Fiery WebSpooler window, the background color for the yellow and white 
printer icons is the same.

Spooled jobs—Jobs listed in the area below the Spool status bar are PostScript files 
stored on the Fiery X3e disk. These jobs were sent to either the Print queue (white 
icons) or the Hold queue (yellow icons).

RIPped jobs—Jobs listed in the area below the RIP status bar are ready to print. They 
have already been rasterized (RIPped, or processed for printing) and are waiting, in 
order, for access to the printer. Rasterized jobs can also be held; held jobs are shown 
with a yellow icon.

Printed jobs—Jobs listed in the area below the Print status bar have already been 
printed. Printed jobs can be stored on the Fiery X3e disk. The number of jobs that can 
be stored (from 1 to 99) is defined in Setup.

If you are logged in as Administrator or Operator, you can interact with a job wherever 
it appears in the window by selecting it and choosing a command from the Job menu, 
or by double-clicking the job and setting override options. See “Manipulating job 
options and job flow” on page 5-4 for information.



55-4 Fiery WebSpooler and Fiery Spooler
Errors—Jobs with an error are shown in red. To display the error, double-click the job 
line. 

NOTE: If your job does not appear anywhere in the Fiery WebSpooler window, it may 
have already been printed; if so, it will appear in the Job Log. To view the Job Log, 
choose Show Job Log from the Window menu. (For more information on the Job Log, 
see page 5-7.)

If the job does not appear in the Job Log, it may have been moved to the Archive 
window by the operator. The Archive window cannot be viewed with 
Fiery WebSpooler; you must contact the operator or look at the Command 
WorkStation display to check this.

Manipulating job options and job flow
Using the commands in the Job menu, you can alter the destinations, priorities and 
other characteristics of jobs that appear in the Fiery WebSpooler window.

To understand the effect each of these commands has on a job, you need to understand 
the way the Fiery X3e handles PostScript and raster data, and how jobs are activated or 
held in the various stages of processing. See Chapter 2 for this background information 
before manipulating jobs with Fiery WebSpooler. Also, the commands in the 
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Fiery WebSpooler Job menu have identical counterparts on the Command 
WorkStation. For information about these commands, see Chapters 2 and 3.

Choose this command 
from the Job menu: To do this: Raster data is:

Delete Job(s) Delete the job(s) from the list Deleted

Cancel Printing Cancel the currently printing job Deleted

Cancel RIPping Cancel the currently processing job Deleted

Duplicate Job(s) Duplicate one or more selected PostScript data 
jobs in the Spool or Print areas (creates a 
reference to the original job, with the same 
name)

n/a
(The Duplicate command is not available for 
raster jobs)

Rename Rename the job (PostScript file with or without 
raster)

Unaffected, but associated with the new name

NOTE: If the renamed job is printed, the Job 
Log reflects the job’s original name.

Hold Hold the job in the current place (except for a 
printed job, which is moved to the Spool or 
RIP area)

Held in RIP area indefinitely, if included with 
job

RIP and Hold RIP the job and hold it in the RIP area Held in RIP area indefinitely

Print Print the job in its turn (RIP it first if it does 
not have raster data). Keep the printed job in 
the Print area until the job limit is reached

Temporarily held in RAM until memory is 
needed for another job

Print and Hold
(like the PPD option 
Save Fast Reprint)

Print the job in its turn (RIP it first if it does 
not have raster data)
After printing, hold the PostScript data and the 
raster in the RIP area

Held in the RIP area indefinitely (saved to 
disk)

Process Next Give top priority to this job
Print the job (or RIP and print) as soon as the 
processor and copier are free, before other 
waiting jobs

Held in RAM after printing (can be selected in 
the Print area while it remains there), or Held 
in RIP area (saved to disk) if destination was 
RIP and Hold

Remove Raster Remove the raster from a job that has raster 
data; leave the PostScript job in place

Deleted



55-6 Fiery WebSpooler and Fiery Spooler
Overriding job option settings
To change the job options of a job, double-click the job line or select the job and 
choose Override Print Settings from the Job menu. If necessary, scroll down to see all 
the job options.

For PostScript files, you cannot override the Orientation option. For PDF files printed 
using Fiery Downloader, you cannot override the following print options:

• Orientation

• Spot Color Matching

Override Print Settings Change the print options for the job
(see page 5-6)

Deleted and regenerated, if the newly selected 
options require reRIPping, or reprinted with 
the new settings, if none require reRIPping

Thumbnail A n/a

Thumbnail B n/a

Choose this command 
from the Job menu: To do this: Raster data is:
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The options you set here are the same ones you set from the Print dialog box when you 
print from an application. For information about setting and overriding these print 
options, see the Printing Guide.

NOTE: For some options, changing the setting requires that the job be reRIPped; these 
options show an icon to the left of the option name.

Using the Job Log
From Fiery WebSpooler, you can view and print a log of all jobs printed by the 
Fiery X3e, including jobs downloaded with Fiery Downloader. 

NOTE: If you logged in as Administrator, you can delete the Job Log from 
Fiery WebSpooler (see page 5-9). The Job Log is not available if you logged in as 
Guest.

TO DISPLAY, UPDATE, PRINT, DELETE, AND SAVE THE JOB LOG:

1. Choose Show Job Log from the Fiery WebSpooler Window menu.

2. Click All or specify a date range.

3. Click OK.

The Job Log appears in a new browser window.
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NOTE: The Delete button appears only if you logged in as Administrator.

The Job Log displays each job and the following information: status, document name, 
user name, date, start time, end time, process time, file size, device, paper size, media, 
number of originals, number of color pages, number of black-and-white pages, total 
number of pages, Note1, and Note2.

The Status column provides the following information about jobs:

4. To update the Job Log, click the Update button.

OK The job was printed normally.

ERROR An error occurred during processing or printing.

CANCEL The job was canceled before printing was completed.

Update

Print

Delete
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5. To print the Job Log, choose Print Job Log from the File menu or click the Print 
button.

The information displayed in the Job Log window prints to the current Fiery X3e. 
When you print the Job Log, totals are printed for all appropriate columns.

6. If you logged in as Administrator, you can choose Delete Job Log from the File menu 
or click the Delete button to clear the Job Log.

The system administrator can also print and clear the Job Log from the Control Panel.

7. To save the Job Log as a tab-delimited text file, choose Export Job Log from the File 
menu or click the Export button. In the File name area, enter a name for the Job Log 
file, browse to the location where you want to save the file, and click Save.

The Job Log is saved as a text file, and the Job Log window reappears.

You can view the information in any application that can read a text file. Items are 
separated by tabs.

To return to the job list, choose Show Job List from the Window menu.

Fiery Spooler for Mac OS computers
If you have purchased the Command WorkStation option, Fiery Spooler for Mac OS is 
included on the Job Management Tools CD.

For Mac OS, the Fiery Spooler interface is almost identical to that of Fiery WebSpooler 
(see “Differences between Fiery Spooler for Mac OS and Fiery WebSpooler” on 
page 5-11), and both interfaces are very similar to the job management interface of the 
Command WorkStation. For details on the icons and commands in Fiery Spooler (and 
Fiery WebSpooler) see Chapters 2 and 3.

TO LAUNCH FIERY SPOOLER ON A MAC OS COMPUTER:

1. Double-click the Fiery Spooler icon.

2. Select the Fiery X3e in the Chooser window that appears.

For information on setting up the connection to the server, see Getting Started.
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3. Click OK.

The Fiery Spooler main window appears.

For information on using Fiery Spooler for Mac OS computers, see “Tracking and 
managing jobs with Fiery WebSpooler” on page 5-1 and Chapters 2 and 3.
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Differences between Fiery Spooler for Mac OS and 
Fiery WebSpooler
Though the interfaces for both Fiery Spooler for Mac OS and Fiery WebSpooler are 
almost identical, there are some feature differences.

Connecting to a different Fiery X3e

With Fiery Spooler, you can connect to a different Fiery X3e from within the 
application using the following procedure.

TO CONNECT TO A DIFFERENT FIERY X3E:

1. Choose Open Fiery from the File menu.

2. Select the Fiery X3e in the Chooser window that appears.

For information on setting up the connection to the server, see Getting Started.

3. Click OK.

The Fiery Spooler main window appears.
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This section lists error messages you might see, and provides some troubleshooting 
guidelines should a problem arise with the Fiery X3e or the Command WorkStation. If 
you are unable to resolve a problem after referring to this chapter, contact your 
authorized service/support center. 

Error messages 
Error messages can result from problems with the print job, the Fiery X3e, the 
Command WorkStation, or the copier. Some of the most common error conditions are 
listed here.

A copier error message sometimes remains displayed on the Command WorkStation 
even after you have resolved the error. A time lag in communicating the resolution of 
the error to the Command WorkStation may lead you to believe the error has not been 
resolved. However, printing will resume and the Command WorkStation display will 
be updated after a short delay.

When an error interferes with printing, you will see a message at the Command 
WorkStation. The status bar that displays the message indicates the process in which 
the error occurred. Following are the messages (listed in alphabetical order), with the 
appropriate corrective action for each one. You can cancel the pending print job while 
you attend to the error condition. A few normal status messages are included in this list 
in case they cause concern.

Fiery X3e message: Corrective action/additional information:

Black imaging unit
near life limit

The black imaging unit needs to be replaced soon. 

Black imaging unit
not set

The black imaging unit is not installed. 

Black imaging unit
not set right

The black imaging unit is not installed correctly. 

Black imaging unit
over life limit

The black imaging unit needs to be replaced. 

Appendix A: 
Troubleshooting
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Black toner 
nearly empty

The black toner needs to be replaced soon. 

Busy The copier is printing. Please wait.

Check power and cable Check the power to the copier and the Fiery X3e.

Clear paper from 
duplex unit

Clear the paper in the duplex unit. Printing will resume when the 
paper has been cleared.

Copier is offline The copier is offline.

Counter not set Copy counter is not set. Printing will be enabled with copy 
counter is set.

Cover open A cover is open on the copier. Printing can resume when the cover 
is closed.

Cyan imaging unit
near life limit

The cyan imaging unit needs to be replaced soon. 

Cyan imaging unit
not set

The cyan imaging unit is not installed. 

Cyan imaging unit
not set right

The cyan imaging unit is not installed correctly.

Cyan imaging unit
over life limit

The cyan imaging unit needs to be replaced.

Cyan toner 
nearly empty

The cyan toner needs to be replaced soon. 

Error. Check Copier See the copier control panel for more information about this error.

Fuser unit near 
life limit

The fuser unit needs to be replaced soon. 

Fuser unit not set The fuser unit is not installed, or not installed correctly.

Fuser unit over
life limit

The fuser unit needs to be replaced. 

Image Stabilizing The copier is stabilizing. Please wait.

Fiery X3e message: Corrective action/additional information:
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Interrupt mode Interrupt key has been pressed. This prevents settings from being 
changed on the copier. Printing or copying can resume when the 
interrupt key is pressed again.

IR waiting Scanner head is warming up.

Load __ OHP
in any tray

Load the specified overhead paper size in any tray.

Load __ OHP
in __

Load the specified overhead paper size in the specified tray.

Load __ plain
in any tray 

Load the specified paper size in any tray.

Load __ Thick1
in any tray

Load the specified Thick 1 paper size in any tray.

Load __ Thick1
in __

Load the specified Thick 1 paper size in the specified tray.

Load __ Thick2
in any tray

Load the specified Thick 2 paper size in any tray.

Load __ Thick2
in __

Load the specified Thick 2 paper size in the specified tray.

Load __
in __

Load the specified paper size in the specified tray.

Magenta imagining 
unit near life limit

The magenta imaging unit needs to be replaced soon. 

Magenta imagining 
unit not set

The magenta imaging unit is not installed. 

Magenta imagining 
unit not set right

The magenta imaging unit is not installed correctly. 

Magenta imagining 
unit over life limit

The magenta imaging unit needs to be replaced. 

Magenta toner nearly 
empty

The magenta toner is nearly empty. 

No black toner The black toner is empty. Replace the black toner.

Fiery X3e message: Corrective action/additional information:
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No cyan toner The cyan toner is empty. Replace the cyan toner.

No magenta toner The magenta toner is empty. Replace the magenta toner.

No staples Stapler is out of staples. Replace staples.

No yellow toner The yellow toner is empty. Replace the yellow toner.

OC roller unit near life 
limit

The OC roller unit is wearing out. It needs to be replaced soon.

OC roller unit over life 
limit

The OC roller unit is worn out. It needs to be replaced.

Original on glass Remove the original from the copier glass.

Paper jam There is a paper jam. Printing can resume when the paper jam is 
cleared.

Power on copier 
with main switch

Power on the copier. Use the main switch on the copier.

Power save mode The copier is in Power Save mode. 

Printing stopped Copier memory card is missing or not properly installed. Printing 
can resume when the copier memory card is installed.

Printing suspended The copier is suspended.

Scanner busy The scanner is scanning. Please wait.

Sleep mode The copier is in sleep mode.

To print, clear 
output area

The output tray is full. Remove the paper from the output tray.

Transfer belt unit near 
life limit

The Transfer belt unit needs to be replaced soon.

Transfer belt unit not 
set

The Transfer belt unit is not installed, or not installed correctly.

Transfer belt unit over 
life limit

The Transfer belt unit needs to be replaced.

Waiting for initializa-
tion

The controller board is being initialized.

Fiery X3e message: Corrective action/additional information:
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Maintaining optimal system performance
The Fiery X3e does not require maintenance. Beyond the routine requirements of 
servicing and maintaining the print engine and replenishing consumables, there are a 
few things you can do to improve the overall performance of your system:

• Reduce unnecessary two-way communication.

If users notice that the server is frequently too busy to receive jobs, it may be because 
several users are running utilities that are updated often. Large numbers of remote 
users running Fiery Downloader or Fiery WebTools may have a significant effect on 
Fiery X3e performance.

Warming up Copier is warming up.

Waste toner bottle 
not set

Waste toner bottle is not installed, or not installed correctly. 
Printing or copying can resume when the waste toner bottle is 
installed.

Waste toner 
full

Empty the waste toner container. 

Waste toner 
nearly full

The waste toner container needs to be replaced soon. 

Web unit near life 
limit

 The Web unit needs to be replaced soon.

Web unit not set  The Web unit is not installed, or not installed correctly.

Web unit over life 
limit

 The Web unit needs to be replaced.

Yellow imaging unit 
near life limit

The yellow imaging unit needs to be replaced soon.

Yellow imaging unit 
not set 

 The yellow imaging unit is not installed. 

Yellow imaging unit 
not set right

 The yellow imaging unit is not installed correctly. 

Yellow toner nearly 
empty

 The yellow toner needs to be replaced soon. 

Fiery X3e message: Corrective action/additional information:
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• Schedule the printing workload by checking job ticket information before printing. 
Print jobs with the same output and paper specifications together to minimize paper 
changes. Also, print routine jobs while you prepare to print jobs with special 
instructions or special media.

• Reduce unnecessary server connections at the Command WorkStation. If you use a 
second or third Fiery X3e server on an occasional basis, performance will be 
improved if you log off when you are not using it.

• Avoid printing with the server Disk full warning. 

If you see this warning, delete jobs from the Queues or Archive windows that have 
been held for a long time and are not likely to be needed. Avoid this condition by 
deleting old jobs on a regular basis. The date associated with a job is the original date 
it was sent. As a last resort, you can use the Clear Server or the Clear command.

Troubleshooting
In case of problems, and before you call for service, check the guidelines in this section. 
If you are unable to resolve the problem, make a note of the error condition and 
contact your authorized service/support center.

Command WorkStation hangs
If the Command WorkStation windows do not update, try clicking the Log in/out 
slider and logging out, and then exiting the Command WorkStation. Restart the 
Command WorkStation application or restart the computer.

If the Command WorkStation windows do not update, or no jobs are displayed, and 
the mouse has no effect (you cannot select a job or a window, use a right mouse 
command, or select a menu item) the Fiery X3e is down or communication over the 
network has failed.

To force an exit from the Command WorkStation application, press Ctrl-Alt-Delete, 
and with the Command WorkStation selected, click End Task. At the Fiery X3e, 
disconnect and reconnect the network cable, and try printing a Test Page or 
Configuration page. If that fails, reboot the server.
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If the Fiery X3e Control Panel does not respond to the Menu button, press the Reset 
button, turn off the server and turn it on again. When it reaches Idle, restart the 
Command WorkStation application.

Command WorkStation fails to connect to a Fiery X3e
If a remote Command WorkStation cannot connect to a server that was connected 
previously, you may need to reconfigure the connection.

1. If you can, choose Exit from the Command WorkStation File menu.

2. In the C:\Windows folder, find the Efinl.ini file and move it out of the C:\Windows 
folder to another folder. 

If the Efinl.ini file contains a limited amount of configuration information that is easily 
recreated (i.e., information for only one or two servers), you can delete the file 
altogether. A new Efinl.ini file will be created in the C:\Windows folder when you 
reconfigure the connection.

If the Efinl.ini file contains configuration information for several servers, or 
information that is not readily recreated, keep the Efinl.ini file as a backup.

3. Print a Configuration page.

You will use the information on this page to configure the connection to the server.

4. Launch the Command WorkStation application.

5. When you are prompted to configure a server connection, click OK. 

Use the instructions in Getting Started to configure the connection.

6. If you still cannot connect to the Fiery X3e, the Administrator should reinstall 
Command WorkStation software. 

See Getting Started for details.
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Unexpected printing results

Clearing the server
Clearing the server is an Administrator option that can be used as a last resort if a job 
persists in the system and prevents printing despite attempts to cancel or delete it. 
Clearing the server deletes all jobs currently saved on the server in any queue, all locally 
archived jobs, and all FreeForm master jobs. It also clears the Job Log, the index of 
archived jobs, and the index of FreeForm masters.

If this happens: This is the problem:

A cover page is not printed 
when you reprint a saved 
raster job.

The cover page identifies the originator of the job and the 
time the job was sent. Time stamp and user information on 
the cover page of a reprinted job are not meaningful.

The job settings are not 
carried out as you expected.

If the user printed from Mac OS, there may be two 
conflicting print settings. You can check the job properties by 
double-clicking the job. See the Printing Guide for a table of 
job properties and conflicting properties. Notify the users of 
these conflicts so they can avoid them in the future.
If you expected the settings you see in the Properties window, 
be aware that the Copies field does not currently reflect user 
settings, and that Page Range and Scale percent are All and 
100%, respectively, unless they were changed after being sent 
for printing.

The job does not print. Some printing errors may be displayed in the Print status bar. 
When the job is in the Printed queue, jobs that had a 
PostScript error are displayed in a light red job row. Double-
click anywhere in the row to see the error message.

There are font errors. If user-specified fonts that are not resident on the Fiery X3e 
are not printing correctly in PostScript files that are 
downloaded by users, request that they embed the fonts in 
the PostScript file or print directly from their application. 
When users print from their applications, if special fonts are 
not downloaded automatically, they should be downloaded 
directly to the Fiery X3e with Fiery Downloader. This can be 
done by the user or by the operator, provided the Direct 
connection is enabled. For information about Fiery 
Downloader, see the Printing Guide.
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Before clearing the server, export the Job Log if you have not recorded the information 
in it. If you can, notify users that you will clear their jobs from the server so they can 
back them up and resend them when the server is back in operation.

You can clear the server from the Control Panel (see page 1-5) or by using the Clear 
command from the Command WorkStation (see page 2-10).

Users are unable to connect to the copier
If users are unable to connect to the copier, or are unable to find the copier from their 
workstations, the network administrator may need to troubleshoot their network 
connections and check settings on the servers they use for printing. If settings have 
changed, it may be necessary to reconfigure the Fiery X3e.

For example, if print servers or print queues on a Novell server are renamed or deleted, 
or if accounts or permissions are changed, the Fiery X3e administrator may have to 
edit settings or enter new settings in IPX (Novell) Setup to reflect the new 
configuration.

If users cannot connect to the copier with Fiery Downloader from Windows 95/98, 
Windows NT 4.0, or Windows 2000, you may need to reconfigure the utility’s 
connection to the server. See Getting Started for details.

Mac OS users may fail to see the copier if a network administrator has assigned it to a 
different zone, or has added zones where previously there were none.

If you have configured the Fiery X3e and set up client computers and network servers 
according to guidelines in the Configuration Guide and Getting Started, try printing a 
Test Page (at the Command WorkStation, choose Print Pages from the File menu).

If you are able to print the test page but still cannot print a file from a remote 
computer, contact the system administrator to troubleshoot the network connection.
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If you are unable to connect, and you cannot print the Test Page, check the copier’s 
touch panel display.

Setup error messages
For information on Setup error messages, see the Configuration Guide.

If this happens: Try this:

It displays a diagnostic or 
error message.

Take the appropriate corrective action, as described in the 
copier manual or in the section “Error messages” on 
page A-1.

The display is completely 
blank.

Check the copier’s Standby function. If the copier is in 
Standby mode, press the Standby key to see any messages on 
the display.

The copier is not in 
Standby mode.

The copier’s Automatic Power-Off function may have shut 
down the copier. 
Turn the copier on, and then try printing a Test Page again 
when the copier has warmed up.

You still cannot print a 
Test Page.

Make a copy. If you can make a copy, restart the Fiery X3e, 
and when you see Idle on the status line of the Fiery X3e 
display, try printing a Test Page again. If the Test Page still 
fails to print, contact your authorized service/support center.
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AutoCal error messages
AutoCal error messages can result from problems during the AutoCal procedure.

Fiery X3e 
message: Additional information:

Error 5 The calibration file cannot be opened.

Error 6 The calibration file was not read correctly.

Error 8 The measurement page did not scan properly, either because it is 
crooked or the data is corrupted.

Error 11 The color strips on the measurement page are inconsistent.

Error 12 The copier model being used is not supported.

Error 20 The measurement page cannot be scanned because the dots per inch 
(dpi) are incorrect.

Error 102 The grayscale strip is crooked or is positioned incorrectly.

Error 103 The grayscale strip is positioned too far to the left or to the right of the 
measurement page.

Error 104 The grayscale strip is positioned too far above the measurement page.

Error 111 The grayscale strip could not be found; either reposition the strip 
correctly or position it vertically.
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deleting 2-27
described 2-26
displaying 5-7
exporting to a file 2-27
Filter 2-28
printing 1-4
printing automatically 2-28

printing from the Command 
WorkStation 3-7

printing from the Control Panel 3-7
specifying a date range 2-27
updating the display 2-27
using (from Fiery WebSpooler) 5-7
viewing printed jobs 5-4

Job menu commands 2-8, 2-9, 5-4, 5-5
Jobs Saved in Printed Queue 2-21
job ticket information 3-4, A-6

rearranging 2-13, 3-4

L
LCD Panel Map, printing 1-4
load balancing between servers 3-19
logging in to a server 2-4
Log in/out slider 2-12, A-6
log in/out slider 2-4
Log out command 2-10, 3-25

M
Manage Color command 3-25
Manage Color option 2-9
Manage Fonts command 2-9, 3-17, 3-25
multiple servers, balancing load 

between 3-19

N
Notes fields 3-2, 3-3, 3-4, 3-14

O
Operator password xvii, 2-5, 4-1, 5-1
Override Print Settings command 5-6

P
Page menu commands 2-9
PANTONE 1-4, 3-7
passwords

Administrator 2-5
for Command WorkStation access 2-1
Operator 2-5, 4-1, 5-1

PDF files, downloading 3-16



I-4 Index
performance, optimizing A-5
permissions xvi, 2-1
Photoshop, transfer functions 3-17
PostScript xiv, 2-14

error 2-20
icon 2-18
RIP xiv

PostScript fonts 1-4
PostScript Test Page, printing 1-4
Preferences dialog box, commands 2-8, 3-5
Preview command 2-9
Print and Hold command 2-8, 2-22, 5-5
Print area 2-2

icons 2-20
Print command 2-8, 2-10, 2-22, 5-5
Printed queue 1-5, 2-2, 2-20, 5-3
printer (job) icon 2-18
printer fonts, see fonts
printing

Archive Log 3-7
Configuration page 3-7
defined xiv
font list 1-4, 3-7
Queues log 3-7
server information pages 3-6

print jobs
routing 2-21 to 2-23

Print Pages command 1-4, 2-8, 3-24
Command WorkStation 3-6

problems,  see troubleshooting
Process Next command 2-8, 2-22, 5-5
Properties command 2-8, 2-22, 3-12
Properties dialog box 3-11

Notes field 3-14

Q
queues 2-14
Queues window 2-5, 2-14

changing the proportions 2-16
deleting held jobs A-6
elements 2-5, 2-6
spooled jobs 2-14
update 3-19

R
RAM 2-14

in use 2-12
total 2-12

raster
data 2-19, 2-21, 5-5
icon 2-18
image 2-14

raster files
saving 2-14

rasterizing, see RIPping
Reboot (server) command 2-10, 3-25
Refresh command 2-10
remote users A-5, A-9
Remove Raster command 2-8, 2-22, 5-5
Rename command 2-8, 2-22, 5-5
restricting access to server xvi
Resume Print command 1-5
Resume Printing command 2-9
Revert to Default Settings command 2-10
right mouse button commands 2-21 to 2-23
RIP, defined xiv
RIP and Hold command 2-8, 2-22, 5-5
RIP area 2-2, 2-19
RIPped jobs 2-2, 5-3
RIPping 2-14
Run Diagnostics command 1-5

S
Send to  command 2-23
Send To Server command 3-20
Send to Server command 2-9
server

clearing the A-8
configuring 2-3
connecting from Command 

WorkStation 2-3, 2-10, 3-19
managing multiple color servers 3-19
selecting another 2-10, 3-19
working with more than one 3-19

server fonts, see fonts
Server Information slider 2-12
Server menu commands 2-9, 2-10



I-5 Index
Server Selection tabs 2-10
Setup command 2-10, 3-25
‘showpage’ after EPS files option 3-17
sliders 2-11
sorting jobs 2-25
spool, defined xiv
Spool area 2-2

job icons 2-18
spooled jobs 2-2

displayed in Fiery WebSpooler 5-3
icons 2-18

status bars 2-2, 2-15
animation 2-15
displaying error 2-15
Print 5-3
RIP 5-3
Spool 5-3

status messages, Touch Panel Display 1-2
Status WebTool, see Fiery WebTools
Suspend Print command 1-5
Suspend Printing command 2-9
switching servers 2-10, 3-19
system information 2-11
system performance A-5

T
Test Page

printing A-10
printing from 

Command WorkStation 3-7
problem printing A-9

Thumbnail A command 2-9, 2-22, 5-6
Thumbnail B command 2-9, 2-22, 5-6
Touch Panel Display

status messages 1-2

troubleshooting
Command WorkStation cannot connect 

to server A-7
Command WorkStation hangs A-6
general guidelines A-6
unexpected printing results A-8
users are unable to connect to the 

printer A-9

U
Undo command 2-9

V
View in Helper App command 2-10
Volume column, in Archive window 2-25

W
warning

"Disk full" A-6
WebDownloader WebTool, see Fiery 

WebTools
WebLink WebTool, see Fiery WebTools
WebScan 4-2
WebSetup WebTool, see Fiery WebTools
WebSpooler,  see Fiery WebSpooler
WebTools, see Fiery WebTools
Window menu commands 2-10
window selection tabs 2-5, 2-13
workflow scenarios 3-8
working with more than one server 3-19
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